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Copyright and License
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 Reproduction, adaptation, or translationwithout prior written permission isprohibited, except as allowed under thecopyright laws.
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Conventions used in this guide
 TIP: Tips provide helpful hints or shortcuts.
 NOTE: Notes provide important information to explain a concept or to complete a task.
 CAUTION: Cautions indicate procedures that you should follow to avoid losing data or damagingthe product.
 WARNING! Warnings alert you to specific procedures that you should follow to avoid personalinjury, catastrophic loss of data, or extensive damage to the product.
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1 Product basics
 ● Product comparison
 ● Environmental features
 ● Product features
 ● Product views
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Product comparison
 HP LaserJet Professional P1100 Printer series HP LaserJet Professional P1100w Printer series
 ● Speed: Up to 18 A4 pages per minute (ppm), 19 letter-size ppm
 ● Tray: 150-sheet input tray
 ● Connectivity: Hi-Speed USB 2.0 port
 ● Duplexing: Manual duplexing (using the printer driver)
 ● Speed: 18 A4 pages per minute (ppm), 19 letter-sizeppm
 ● Trays: 150-sheet main-input tray and 10-sheet priorityinput slot
 ● Connectivity: Hi-Speed USB 2.0 port and 802.11b/gwireless networking
 ● Duplexing: Manual duplexing (using the printer driver)
 Environmental features
 Recycling Reduce waste by using recycled paper.
 Recycle print cartridges by using the HP return process.
 Energy savings Save energy with product Auto-Off mode.
 Duplex Save paper by using the manual duplex printing setting.
 HP Smart Web Printing Use HP Smart Web Printing to select, store, and organize text and graphics from multiple Webpages and then edit and print exactly what you see onscreen. It gives you the control you need forprinting meaningful information while minimizing waste.
 Download HP Smart Web Printing from this Web site: www.hp.com/go/smartweb.
 2 Chapter 1 Product basics ENWW
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Product features
 Benefit Supporting features
 Excellent printquality
 ● Genuine HP print cartridge.
 ● FastRes 600 setting provides 600 dots per inch (dpi) effective print quality. FastRes 1200setting provides 1,200 dpi effective print quality.
 ● Adjustable settings to optimize print quality.
 Supported operatingsystems
 ● Windows Vista (32-bit and 64-bit)
 ● Windows XP (32-bit and 64-bit)
 ● Windows 7
 ● Windows Server 2003 (32-bit and 64-bit)
 ● Windows Server 2008 (32-bit and 64-bit)
 ● Mac OS X v10.4, v10.5, v10.6
 Ease of use ● HP Smart Install feature installs product software when you connect a USB cable between theproduct and a Windows computer.
 ● The print cartridge is easy to install.
 ● Convenient access to the print cartridge and to the paper path through the print-cartridgedoor.
 ● Paper tray can be adjusted with one hand.
 Flexible paperhandling
 ● A 10-sheet priority input slot (wireless models only)
 ● A 150-sheet (75 g/m2 (20 lb) paper) input tray.
 ● A 125-sheet (75 g/m2 (20 lb) paper) output bin.
 ● Manual duplexing (two-sided printing).
 Interface connections ● Hi-Speed USB 2.0 port
 ● 802.11b/g wireless networking (wireless models only)
 Energy savings ● After a user-specified time, the Auto-Off feature automatically conserves electricity bysubstantially reducing power consumption when the product is not printing.
 Economical printing ● N-up printing (printing more than one page on a sheet) and the manual two-sided printingfeatures save paper.
 ● EconoMode printer driver feature saves toner.
 Suppliesmanagement
 ● Authentication for genuine HP print cartridges.
 ● Easy ordering for replacement supplies.
 ● Supplies status page shows estimated toner level in the print cartridge. Not available for non-HP supplies.
 ENWW Product features 3
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Benefit Supporting features
 Accessibility ● The online user guide is compatible with text screen-readers.
 ● All doors and covers can be opened by using one hand.
 Security ● Kensington lock receptacle on the back of the product.
 4 Chapter 1 Product basics ENWW
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Product views
 Front and left side view
 3
 2
 5
 6
 1
 7
 4
 1 Output bin
 2 Foldable output tray extension
 3 Input tray
 4 Short media extender tool
 5 Power button
 6 Print-cartridge door lift-tab
 7 Control panel
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3
 2
 5
 6
 1
 7
 4
 1 Output bin
 2 Foldable output tray extension
 3 Priority input slot
 4 Main input tray
 5 Power button
 6 Print-cartridge door lift-tab
 7 Control panel
 6 Chapter 1 Product basics ENWW
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Back view
 2
 1
 3
 1 USB port
 2 Power connector
 3 Kensington lock
 Serial number and product number location
 The label that contains the product number and serial number is on the rear of the product.
 ENWW Product views 7
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Control-panel layout
 NOTE: See Interpret control-panel light patterns on page 80 for a description of what the lightpatterns mean.
 2
 1
 1 Attention light: Indicates that the print cartridge door is open or other errors exist.
 2 Ready light: When the product is ready to print, the ready light is on. When the product is processing data, theready light blinks.
 2
 3
 4
 5
 1
 1 Wireless button: To detect wireless networks, press the wireless button. This button also enables and disables thewireless feature.
 2 Wireless light: When the product is searching for a network, the wireless light blinks. When the product is connected toa wireless network, the wireless light is on.
 3 Attention light: Indicates that the print cartridge door is open or other errors exist.
 8 Chapter 1 Product basics ENWW
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4 Ready light: When the product is ready to print, the ready light is on. When the product is processing data, theready light blinks.
 5 Cancel button: To cancel the print job, press the cancel button. Press and hold the button for 5 seconds to print aconfiguration page.
 ENWW Product views 9
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2 Software for Windows
 ● Supported operating systems for Windows
 ● Supported printer-drivers for Windows
 ● Priority for print settings
 ● Change printer-driver settings for Windows
 ● Remove software for Windows
 ● Supported utilities (wireless models only)
 ENWW 11
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Supported operating systems for WindowsThe product comes with software for the following Windows® operating systems:
 ● Windows Vista (32-bit and 64-bit)
 ● Windows XP (32-bit and 64-bit)
 ● Windows 7
 ● Windows Server 2003 (32-bit and 64-bit)
 For more information about upgrading from Windows 2000 Server to Windows Server 2003,using Windows Server 2003 Point and Print, or using Windows Server 2003 Terminal Servicesand Printing, go to www.microsoft.com.
 ● Windows Server 2008 (32-bit and 64-bit)
 Supported printer-drivers for WindowsThe product comes with software for Windows that allows the computer to communicate with theproduct. This software is called a printer driver. Printer drivers provide access to product features, suchas printing on custom-sized paper, resizing documents, and inserting watermarks.
 NOTE: The most recent drivers are available at www.hp.com/support/ljp1100series. Depending onthe configuration of Windows-based computers, the installation program for the product softwareautomatically checks the computer for Internet access in order to obtain the latest drivers.
 In addition to the printer driver that is installed during the HP Smart Install or from the product CD, theXML Paper Specification (XPS) driver is available for download from the Web.
 12 Chapter 2 Software for Windows ENWW
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Priority for print settingsChanges to print settings are prioritized depending on where the changes are made:
 NOTE: The names of commands and dialog boxes might vary depending on your software program.
 ● Page Setup dialog box: Click Page Setup or a similar command on the File menu of theprogram you are working in to open this dialog box. Settings changed here override settingschanged anywhere else.
 ● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of theprogram you are working in to open this dialog box. Settings changed in the Print dialog boxhave a lower priority and usually do not override changes made in the Page Setup dialog box.
 ● Printer Properties dialog box (printer driver): Click Properties in the Print dialog boxto open the printer driver. Settings changed in the Printer Properties dialog box usually do notoverride settings anywhere else in the printing software. You can change most of the print settingshere.
 ● Default printer driver settings: The default printer driver settings determine the settings usedin all print jobs, unless settings are changed in the Page Setup, Print, or Printer Propertiesdialog boxes.
 ENWW Priority for print settings 13

Page 28
                        

Change printer-driver settings for Windows
 Change the settings for all printjobs until the software programis closed
 Change the default settings forall print jobs
 Change the product configurationsettings
 1. On the File menu in the softwareprogram, click Print.
 2. Select the driver, and then clickProperties or Preferences.
 The steps can vary; this procedure ismost common.
 1. Windows Vista andWindows 7: Click Start, clickControl Panel, and then in thecategory for Hardware andSound click Printer.
 -or-
 Windows XP, WindowsServer 2003, and WindowsServer 2008 (using thedefault Start menu view):Click Start, and then clickPrinters and Faxes.
 -or-
 Windows XP, WindowsServer 2003, and WindowsServer 2008 (using theClassic Start menu view):Click Start, click Settings, andthen click Printers.
 2. Right-click the driver icon, and thenselect Printing Preferences.
 1. Windows Vista andWindows 7: Click Start, clickControl Panel, and then in thecategory for Hardware andSound click Printer.
 -or-
 Windows XP, WindowsServer 2003, and WindowsServer 2008 (using thedefault Start menu view):Click Start, and then clickPrinters and Faxes.
 -or-
 Windows XP, WindowsServer 2003, and WindowsServer 2008 (using theClassic Start menu view):Click Start, click Settings, andthen click Printers.
 2. Right-click the driver icon, and thenselect Properties.
 3. Click the Device Settings tab.
 14 Chapter 2 Software for Windows ENWW
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Remove software for Windows
 Use the uninstall utility to remove Windows software
 1. Click the Start button, and then click the Programs or All Programs menu item.
 2. Click the HP menu item, and then click the HP LaserJet Professional P1100 Printer seriesmenu item.
 3. Click the Uninstall menu item, and then follow the onscreen instructions to remove the software.
 Use the Windows Control Panel to remove software
 Windows XP, Windows Server 2003, and Windows Server 2008
 1. Click the Start button, click the Control Panel item, and then click the Add or RemovePrograms item.
 2. Find and select the product from the list.
 3. Click the Change/Remove button to remove the software.
 Windows Vista and Windows 7
 1. Click the Start button, click the Control Panel item, and then click the Programs andFeatures item.
 2. Find and select the product from the list.
 3. Select the Uninstall/Change option.
 ENWW Remove software for Windows 15
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Supported utilities (wireless models only)
 Embedded Web server
 The product is equipped with an embedded Web server, which provides access to information aboutproduct and network activities. This information appears in a Web browser, such as Microsoft InternetExplorer, Apple Safari, or Firefox.
 The embedded Web server resides on the product. It is not loaded on a network server.
 The embedded Web server provides an interface to the product that anyone who has a network-connected computer and a standard Web browser can use. No special software is installed orconfigured, but you must have a supported Web browser on your computer. To gain access to theembedded Web server, type the IP address for the product in the address line of the browser. (To findthe IP address, print a configuration page. For more information about printing a configuration page,see Print the information pages on page 56.)
 For a complete explanation of the features and functionality of the embedded Web server, seeHP Embedded Web Server sections on page 58.
 16 Chapter 2 Software for Windows ENWW
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3 Use the product with Mac
 ● Software for Mac
 ● Print with Mac
 ENWW 17
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Software for Mac
 Supported operating systems for Macintosh
 The product supports the following Macintosh operating systems:
 ● Mac OS X v10.4, v10.5, and v10.6
 NOTE: PPC and Intel® Core™ processors are supported.
 Supported printer drivers for Macintosh
 The HP LaserJet software installer provides PostScript® Printer Description (PPD) files, a CUPS driver,and the HP Printer Utilities for Mac OS X. The HP printer PPD file, in combination with the CUPS driver,provides full printing functionality and access to specific HP printer features.
 Remove software for Mac
 Use the uninstall utility to remove the software.
 1. Browse to the following folder:
 Library/Printers/hp/laserjet/P1100_P1560_P1600Series/
 2. Double-click the HP Uninstaller.app file.
 3. Click the Continue button, and then follow the onscreen instructions to remove the software.
 Priority for print settings for Mac
 Changes to print settings are prioritized depending on where the changes are made:
 NOTE: The names of commands and dialog boxes might vary depending on your software program.
 ● Page Setup dialog box: Click Page Setup or a similar command on the File menu of theprogram you are working in to open this dialog box. Settings changed here might overridesettings changed anywhere else.
 ● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of theprogram you are working in to open this dialog box. Settings changed in the Print dialog boxhave a lower priority and do not override changes made in the Page Setup dialog box.
 ● Default printer driver settings: The default printer driver settings determine the settings usedin all print jobs, unless settings are changed in the Page Setup or Print dialog boxes.
 18 Chapter 3 Use the product with Mac ENWW
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Change printer-driver settings for Macintosh
 Change the settings for all printjobs until the software programis closed
 Change the default settings forall print jobs
 Change the product configurationsettings
 1. On the File menu, click Print.
 2. Change the settings that you wanton the various menus.
 1. On the File menu, click Print.
 2. Change the settings that you wanton the various menus.
 3. On the Presets menu, click Saveas and type a name for the preset.
 These settings are saved in the Presetsmenu. To use the new settings, you mustselect the saved preset option every timeyou open a program and print.
 Mac OS X v10.4
 1. From the Apple menu, clickSystem Preferences and thenPrint & Fax.
 2. Click Printer Setup.
 3. Click the Installable Optionsmenu.
 Mac OS X v10.5 and v10.6
 1. From the Apple menu, clickSystem Preferences and thenPrint & Fax.
 2. Click Options & Supplies.
 3. Click the Driver menu.
 4. Select the driver from the list, andconfigure the installed options.
 ENWW Software for Mac 19
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Software for Mac computers
 HP Printer Utility for Mac
 Use the HP LaserJet Utility to print the product information pages and to change the Auto-Off settingfrom a Mac computer.
 To open the HP LaserJet Utility, complete the procedure below.
 ▲ Open the Print Queue, and then click the Utility icon.
 Install software for Mac computers on a wireless network
 Before installing the product software, make sure the product is not connected to the network using anetwork cable.
 NOTE: You must have Mac OS X V10.6 to install the product on a wireless network.
 To connect the product to a computer on a wireless network, follow these steps:
 1. Open Finder in the dashboard.
 2. Click Applications, and then double-click System Preferences, and then click Print & Fax.
 3. Open Print Queue, click Printer Setup, click the Utility tab, and then click Open PrinterUtility.
 4. Click HTMLConfig.
 5. Click the Networking tab, and then click Wireless in the list on the left.
 6. Under Communication Mode, click Infrastructure, select a network name from the AvailableNetwork Names (SSID) list, and then click the << button.
 7. From the Security Mode pop-up menu under Authentication, click WEP.
 8. Type the WEP key and then click Apply.
 9. Click OK in the confirmation box.
 10. Close the HTML Config windows and the Print Queue window.
 11. In the Print & Fax window, choose the USB option (listed with the product model) and then clickthe minus - button.
 12. When the window with the list of printers appears, choose the Bonjour option (listed with theproduct model), and then click Add.
 20 Chapter 3 Use the product with Mac ENWW

Page 35
                        

Supported utilities for Mac (wireless models only)
 Embedded Web server
 Network models are equipped with an embedded Web server, which provides access to informationabout device and network activities. This information appears in a Web browser, such as MicrosoftInternet Explorer, Netscape Navigator, Apple Safari, or Firefox.
 The embedded Web server resides on the device. It is not loaded on a network server.
 The embedded Web server provides an interface to the device that anyone who has a network-connected computer and a standard Web browser can use. No special software is installed orconfigured, but you must have a supported Web browser on your computer. To gain access to theembedded Web server, type the IP address for the device in the address line of the browser. (To findthe IP address, print a configuration page.)
 ENWW Software for Mac 21
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Print with Mac
 Create and use printing presets in Macintosh
 Use printing presets to save the current printer driver settings for reuse.
 Create a printing preset
 1. On the File menu, click Print.
 2. Select the driver.
 3. Select the print settings.
 4. In the Presets box, click Save As..., and type a name for the preset.
 5. Click OK.
 Use printing presets
 1. On the File menu, click Print.
 2. Select the driver.
 3. In the Presets box, select the printing preset that you want to use.
 NOTE: To use printer-driver default settings, select Standard.
 Resize documents or print on a custom paper size
 You can scale a document to fit on a different size of paper.
 1. On the File menu, click Print.
 2. Open the Paper Handling menu.
 3. In the area for Destination Paper Size, select Scale to fit paper size, and then select thesize from the drop-down list.
 4. If you want to use only paper that is smaller than the document, select Scale down only.
 Print a cover page
 You can print a separate cover page for your document that includes a message (such as“Confidential”).
 1. On the File menu, click Print.
 2. Select the driver.
 22 Chapter 3 Use the product with Mac ENWW

Page 37
                        

3. Open the Cover Page menu, and then select whether to print the cover page BeforeDocument or After Document.
 4. In the Cover Page Type menu, select the message that you want to print on the cover page.
 NOTE: To print a blank cover page, select Standard as the Cover Page Type.
 Print multiple pages on one sheet of paper in Macintosh
 You can print more than one page on a single sheet of paper. This feature provides a cost-effective wayto print draft pages.
 1. On the File menu, click Print.
 2. Select the driver.
 3. Open the Layout menu.
 4. Next to Pages per Sheet, select the number of pages that you want to print on each sheet (1,2, 4, 6, 9, or 16).
 5. Next to Layout Direction, select the order and placement of the pages on the sheet.
 6. Next to Borders, select the type of border to print around each page on the sheet.
 Print on both sides (duplex)
 Print on both sides manually
 1. Insert enough paper into the input tray to accommodate the print job. If you are loading specialpaper such as letterhead, load it face-down in the tray.
 2. On the File menu, click Print.
 3. Mac OS X v10.4: In the Layout drop-down list, select the Long-edged binding item or theShort-edged binding item.
 -or-
 Mac OS X v10.5 and v10.6: Click the Two-sided check box.
 4. Click Print. Follow the instructions in the dialog box that opens on the computer screen beforeplacing the output stack in the tray for printing the second half.
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5. Go to the product, and remove any blank paper that is in the tray.
 6. Take the printed stack from the output bin, and then insert the stack printed side down into the traywith the top edge feeding into the product first.
 7. At the computer, click the Continue button to finish the print job.
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4 Connect the product
 ● Supported network operating systems (wireless models only)
 ● USB connection
 ● Network connection (wireless models only)
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Supported network operating systems (wirelessmodels only)
 The product supports the following operating systems for wireless printing:
 ● Windows Vista (32-bit and 64-bit)
 ● Windows XP (32-bit and 64-bit)
 ● Windows 7
 ● Windows Server 2003 (32-bit and 64-bit)
 ● Windows Server 2008 (32-bit and 64-bit)
 ● Mac OS X v10.4, v10.5, and v10.6
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USB connectionThis product supports a Hi-Speed USB 2.0 connection. You must use an A-to-B type USB cable that is nolonger than 2 m (6.56 ft).
 HP Smart Install
 NOTE: This installation type is supported for Windows only.
 The HP Smart Install allows you to install the product driver and software by connecting the product to acomputer through a USB cable.
 NOTE: The installation CD is not required during a HP Smart Install. Do not insert the softwareinstallation CD into the computer CD drive.
 1. Turn the product on.
 2. Connect the USB cable.
 3. The HP Smart Install program should start automatically. Follow the onscreen instructions to installthe software.
 ● If the HP Smart Install program does not start automatically, AutoPlay might be disabled onthe computer. Browse the computer and double-click the HP Smart Install drive to run theprogram. If you cannot find the HP Smart Install drive, use the product installation CD toinstall the software.
 ● If the program prompts you to select a connection type, select the connection type you willuse to print to the product after installation.
 CD installation
 1. Insert the software installation CD into the computer CD drive.
 NOTE: Do not connect the USB cable until prompted.
 2. If the installation program does not start automatically, browse the CD contents and run theSETUP.EXE file.
 3. Follow the onscreen instructions to install the software.
 When you use the CD to install the software, you can choose the following types of installations:
 ● Easy Install (recommended)
 You will not be prompted to accept or make changes to default settings, and you automaticallywill accept the software license agreement.
 ● Advanced Install
 You will be prompted to accept or make changes to default settings.
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Network connection (wireless models only)The product can connect to wireless networks.
 Supported network protocols
 To connect a networking-equipped product to a network, you need a network that uses one of thefollowing protocols.
 ● TCP/IP (IPv4 or IPv6)
 ● Port 9100
 ● LPR
 ● DHCP
 ● AutoIP
 ● SNMP
 ● Bonjour
 ● SLP
 ● WSD
 ● NBNS
 Install the product on a wireless network with HP Smart Install
 NOTE: This installation type is supported for Windows only.
 The HP Smart Install allows you to install the product driver and software by connecting the product to acomputer through a USB cable. If the product previously has been installed on a network, reset thewireless defaults. See Restore default wireless settings on page 31.
 NOTE: The installation CD is not required during a HP Smart Install. Do not insert the softwareinstallation CD into the computer CD drive.
 1. Turn on the product, and then connect the USB cable to the product and the computer. Theinstallation program should start automatically.
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● If the HP Smart Install program does not start automatically, AutoPlay might be disabled onthe computer. Browse the computer and double-click the HP Smart Install drive to run theprogram. If you cannot find the HP Smart Install drive, use the product installation CD toinstall the software.
 ● If the program prompts you to select a connection type, select the connection type you willuse to print to the product after installation.
 2. Follow the onscreen instructions to complete the product installation.
 3. When the installation is complete, if you want to verify that the product has a network IP address,print a configuration page. Press and hold the product cancel button until the ready lightblinks, and then release the button to print the configuration page.
 Install the product on a wireless network with the software CD
 1. Insert the software CD into the computer CD tray.
 If the installation program does not start automatically, browse the CD contents and run theSETUP.EXE file.
 2. Follow the onscreen instructions to complete the product installation.
 3. When the installation is complete, if you want to verify that the product has a network IP address,print a configuration page. Press and hold the product cancel button until the ready lightblinks, and then release the button to print the configuration page.
 Install the software for a product currently on the network
 When the product previously has been installed on a network computer (so that it already has an IPaddress), and you want to install the printer driver on another computer, complete the following steps.
 1. At the computer, open the HP Embedded Web Server. See Open the HP Embedded Web Serverby using a network connection on page 57.
 2. Click the HP Smart Install tab.
 3. Click the Download button.
 4. Follow the onscreen instructions to complete the product installation.
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Perform a peer-to-peer (ad-hoc) wireless installation
 The product can be installed wirelessly to a computer through a peer-to-peer (ad-hoc) installation.
 1. Turn on the product, and then restore the network setting.
 2. Print a configuration page (see Configuration page on page 56), and find the network name(SSID) in the Network Information section.
 3. Refresh the computer wireless network connection list, and then click the product network name(SSID) and connect to it.
 4. After several minutes, print a configuration page, and then find the product IP address.
 5. At the computer, open a web browser, type the product IP address in the address box, and thenpress the Enter key to open the HP Embedded Web Server.
 6. Click the HP Smart Install tab, and then click the Download button to install the productsoftware.
 The figures below show the difference between an ad-hoc network connection and an infrastructurenetwork connection.
 Ad-hoc network Infrastructure network
 Turn off the product wireless unit
 If you want to disconnect the product from a wireless network, you can turn off the wireless unit in theproduct.
 1. At the product control panel, press and hold the wireless button for more than 5 seconds.
 2. To confirm that the wireless unit is turned off, print a configuration page, and then verify that theproduct IP address is specified as 0.0.0.0 on the configuration page.
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Configure the network product
 Use the Wireless Configuration utility
 Use the Wireless Configuration utility to configure the product to print on a wireless network.
 1. Connect the wireless product to the computer through a USB cable.
 2. Click the Start button, and then click the Programs or All Programs menu item.
 3. Click the HP menu item, and then click the HP LaserJet Professional P1100 Printer seriesmenu item.
 4. Click the Wireless Configuration menu item.
 5. Follow the onscreen instructions to configure the product to print on a wireless network.
 Restore default wireless settings
 1. Turn the product off.
 2. Press and hold the wireless button and the cancel button, and then turn the product on.
 3. Hold the buttons until all the lights blink in unison, and then release the buttons.
 View or change network settings
 Use the embedded Web server to view or change IP configuration settings.
 1. Print a configuration page, and locate the IP address.
 ● If you are using IPv4, the IP address contains only digits. It has this format:
 xxx.xxx.xxx.xxx
 ● If you are using IPv6, the IP address is a hexadecimal combination of characters and digits. Ithas a format similar to this:
 xxxx::xxxx:xxxx:xxxx:xxxx
 2. To open the embedded Web server, type the IP address into the address line of a Web browser.
 3. Click the Networking tab to obtain network information. You can change settings as needed.
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Set or change the network password
 Use the embedded Web server to set a network password or change an existing password.
 1. Open the embedded Web server, click the Networking tab, and click the Password link.
 NOTE: If a password has previously been set, you are prompted to type the password. Type thepassword, and then click the Apply button.
 2. Type the new password in the Password box and in the Confirm Password box.
 3. At the bottom of the window, click the Apply button to save the password.
 IP address
 The product IP address can be set manually, or it can be configured automatically using DHCP, BootP,or AutoIP.
 To change the IP address manually, use the HP Embedded Web Server.
 1. Open the HP Embedded Web Server, and then click the Networking tab.
 2. In the navigation pane, click the IPv4 Configuration link or the IPv6 Configuration link.
 3. In the IP Address Configuration section, click the Manual IP option.
 4. Type the required data in the Manual IP Address box, the IP Subnet Mask box, and theManual Default Gateway box.
 5. Click the Apply button.
 Link speed setting
 Use the Networking tab in the HP Embedded Web Server to set the link speed if necessary. Thesetting is on the Advanced page.
 Incorrect changes to the link speed setting might prevent the product from communicating with othernetwork devices. For most situations, leave the product in automatic mode. Changes can cause theproduct to turn off, and then on. Only make changes when the product is idle.
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5 Paper and print media
 ● Understand paper and print media use
 ● Special paper or print media guidelines
 ● Change the print driver to match the media type and size
 ● Supported paper sizes
 ● Supported paper types and tray capacity
 ● Paper orientation for loading trays
 ● Load paper trays
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Understand paper and print media useThis product supports a variety of paper and other print media in accordance with the guidelines in thisuser guide. Paper or print media that does not meet these guidelines might cause poor print quality,increased jams, and premature wear on the product.
 For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Donot use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommendthe use of other brands of media because HP cannot control their quality.
 It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactoryresults. This might be the result of improper handling, unacceptable temperature and/or humidity levels,or other variables over which Hewlett-Packard has no control.
 CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications mightcause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packardwarranty or service agreements.
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Special paper or print media guidelinesThis product supports printing on special media. Use the following guidelines to obtain satisfactoryresults. When using special paper or print media, be sure to set the type and size in the printer driverto obtain the best results.
 CAUTION: HP LaserJet products use fusers to bond dry toner particles to the paper in very precisedots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper could damage theproduct.
 Media type Do Do not
 Envelopes ● Store envelopes flat.
 ● Use envelopes where the seamextends all the way to the corner ofthe envelope.
 ● Use peel-off adhesive strips that areapproved for use in laser printers.
 ● Do not use envelopes that arewrinkled, nicked, stuck together, orotherwise damaged.
 ● Do not use envelopes that haveclasps, snaps, windows, or coatedlinings.
 ● Do not use self-stick adhesives orother synthetic materials.
 Labels ● Use only labels that have noexposed backing between them.
 ● Use labels that lie flat.
 ● Use only full sheets of labels.
 ● Do not use labels that havewrinkles or bubbles, or aredamaged.
 ● Do not print partial sheets of labels.
 Transparencies ● Use only transparencies that areapproved for use in laser printers.
 ● Place transparencies on a flatsurface after removing them fromthe product.
 ● Do not use transparent print medianot approved for laser printers.
 Letterhead or preprinted forms ● Use only letterhead or formsapproved for use in laser printers.
 ● Do not use raised or metallicletterhead.
 Heavy paper ● Use only heavy paper that isapproved for use in laser printersand meets the weight specificationsfor this product.
 ● Do not use paper that is heavierthan the recommended mediaspecification for this product unlessit is HP paper that has beenapproved for use in this product.
 Glossy or coated paper ● Use only glossy or coated paperthat is approved for use in laserprinters.
 ● Do not use glossy or coated paperdesigned for use in inkjet products.
 ENWW Special paper or print media guidelines 35

Page 50
                        

Change the print driver to match the media typeand size
 Selecting media by type and size results in significantly better print quality for heavy paper, glossypaper, and overhead transparencies. Using the wrong setting can result in unsatisfactory print quality.Always print by type for special print media, such as labels or transparencies. Always print by size forenvelopes.
 NOTE: Depending on the software program, the commands and dialog box names that follow mightbe different.
 1. On the File menu in the software program, click the Print menu item.
 2. Select the driver, and then click the Properties button or the Preferences button.
 3. Click the Paper/Quality tab.
 4. In the Type is or Size is list box, select the correct media type or size.
 5. Click the OK button.
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Supported paper sizesThis product supports various paper sizes, and it adapts to various media.
 NOTE: To obtain best print results, select the appropriate paper size and type in your print driverbefore printing.
 Table 5-1 Supported paper and print media sizes
 Size Dimensions Input tray Priority input slot(wireless modelsonly)
 Letter 216 x 279 mm (8.5 x 11 in)
 Legal 216 x 356 mm (8.5 x 14 in)
 A4 210 x 297 mm (8.27 x 11.69 in)
 Executive 184 x 267 mm (7.25 x 10.5 in)
 A5 148 x 210 mm (5.83 x 8.27 in)
 A6 105 x 148 mm (4.13 x 5.83 in)
 B5 (JIS) 182 x 257 mm (7.17 x 10.12 in)
 16k 184 x 260 mm (7.24 x 10.23 in)
 195 x 270 mm (7.68 x 10.62 in)
 197 x 273 mm (7.75 x 10.75 in)
 Custom Minimum: 76 x 127 mm (3 x 5 in)
 Maximum: 216 x 356 mm (8.5 x 14.0 in)
 Table 5-2 Supported envelopes and postcards
 Size Dimensions Input tray Priority input slot(wireless modelsonly)
 Envelope #10 105 x 241 mm (4.13 x 9.49 in)
 Envelope DL 110 x 220 mm (4.33 x 8.66 in)
 Envelope C5 162 x 229 mm (6.93 x 9.84 in)
 Envelope B5 176 x 250 mm (6.7 x 9.8 in)
 Envelope Monarch 98 x 191 mm (3.9 x 7.5 in)
 Double postcard(JIS)
 148 x 200 mm (5.83 x 7.87 in)
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Supported paper types and tray capacity
 Supported paper and print media types
 For a complete list of specific HP-brand paper that this product supports, go to www.hp.com/support/ljp1100series.
 Paper type (printer driver) Input tray Priority input slot (wireless modelsonly)
 Paper, including the following types:
 ● Plain
 ● Vellum
 ● Recycled
 Rough
 Envelope
 Labels
 Cardstock
 Transparency
 Postcards
 Tray and bin capacity
 Tray or bin Paper type Specifications Quantity
 Input tray Paper Range:
 60 g/m2 (16 lb) bond to 163 g/m2 (43 lb) bond
 150 sheets of 75 g/m2 (20 lb)bond
 Envelopes 60 g/m2 (16 lb) bond to 90 g/m2 (24 lb) bond
 Up to 10 envelopes
 Transparencies Minimum 0.13 mm (0.005 in)thick
 Up to 75 transparencies
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Tray or bin Paper type Specifications Quantity
 Output bin Paper Range:
 60 g/m2 (16 lb) bond to 163 g/m2 (43 lb) bond
 Up to 125 sheets of 75 g/m2
 (20 lb) bond
 Envelopes Less than 60 g/m2 (16 lb) bondto 90 g/m2 (24 lb) bond
 Up to 10 envelopes
 Transparencies Minimum 0.13 mm (0.005 in)thick
 Up to 75 transparencies
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Paper orientation for loading traysIf you are using paper that requires a specific orientation, load it according to the information in thefollowing table.
 Paper type How to load paper
 Preprinted or letterhead ● Face up
 ● Top edge leading into the product
 Prepunched ● Face up
 ● Holes toward the left side of the product
 Envelope ● Face up
 ● Left short edge leading into the product
 Load paper traysCAUTION: If you try to print on media that is wrinkled, folded, or damaged in any way, a jam mightoccur. See Clear jams on page 83 for more information.
 Priority feed slot
 The priority feed slot holds up to 10 sheets of media or one envelope, one transparency, or one sheetof labels or cardstock. Load media with the top forward and the side to be printed on facing up. Toprevent jams and skewing, always adjust the side media guides before feeding the media.
 Input tray
 The input tray holds 150 pages of 75 g/m2 (20 lb) paper, or fewer sheets of heavier media (a 15 mm(0.6 in) stack height or less).
 Load media with the top forward and the side to be printed on facing up. To prevent jams andskewing, always adjust the side and front media guides.
 NOTE: When you add new media, make sure that you remove all of the media from the input trayand straighten the entire stack. This helps prevent multiple sheets of media from feeding through theproduct at one time, reducing media jams.
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Tray adjustment for short media (base models only)
 To print on media shorter than 185 mm (7.28 in), use the short media extender to adjust your inputtray.
 1. Remove the short media extender tool from the storage slot on the left side of the media inputarea.
 2. Attach the tool to the adjustable media guide.
 3. Insert the media into the product until it stops, and then slide the adjustable media guide, with thetool attached to support the media.
 4. When finished printing with short media, remove the short media extender tool, and then place itback in the storage slot.
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6 Print tasks
 ● Cancel a print job
 ● Print with Windows
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Cancel a print jobYou can stop a print job by using the software program.
 NOTE: It can take several minutes for all print jobs to clear after you have canceled a print job.
 Stop the current print job from the control panel (wireless modelsonly)
 ▲ Press the cancel button on the control panel.
 Stop the current print job from the software program
 When you send the print job, a dialog box opens briefly on the screen, giving you the option to cancelthe print job.
 If several jobs are sent to the product through your software, they might be waiting in a print queue (forexample, in Windows Print Manager). See the software program documentation for specific instructionsabout canceling a print job from the computer.
 If a print job is waiting in a print queue or print spooler, delete the print job there.
 1. Windows Vista and Windows 7: Click Start, click Control Panel, and then in thecategory for Hardware and Sound click Printer.
 -or-
 Windows XP, Windows Server 2003, and Windows Server 2008 (using thedefault Start menu view): Click Start, click Settings, and then click Printers and Faxes.
 -or-
 Windows XP, Windows Server 2003, and Windows Server 2008 (using theClassic Start menu view): Click Start, click Settings, and then click Printers.
 2. In the list of printers, double-click the name of this product to open the print queue or spooler.
 3. Select the print job that you want to cancel, right-click the job, and then click the Cancel orDelete item.
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Print with WindowsNOTE: Depending on the software program, the commands and dialog box names that follow mightbe different.
 Open the Windows printer driver
 1. On the File menu in the software program, click Print.
 2. Select the product, and then click Properties or Preferences.
 Get help for any print option with Windows
 Printer-driver Help is separate from program Help. The printer-driver help provides explanations for thebuttons, check boxes, and drop-down lists that are in the printer driver. It also includes instructions forperforming common printing tasks, such as printing on both sides, printing multiple pages on one sheet,and printing the first page or covers on different paper.
 Activate the printer-driver Help screens in one of the following ways:
 ● In the printer driver Properties dialog box, click the Help button.
 ● Press the F1 key on the computer keyboard.
 ● Click the question-mark symbol in the upper-right corner of the printer driver.
 ● Right-click on any item in the driver.
 Change the number of print copies with Windows
 1. Open the printer driver, click the Properties or Preferences button, and then click theAdvanced tab.
 2. In the Copies area, use the arrow buttons to adjust the number of copies.
 If you are printing multiple copies, click the Collate check box to collate the copies.
 3. Click the OK button.
 Print colored text as black with Windows
 1. Open the printer driver, click the Properties or Preferences button, and then click theAdvanced tab.
 2. Click the Print All Text as Black check box.
 3. Click the OK button.
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Save custom print settings for reuse with Windows
 Use a printing quick set
 1. Open the printer driver, and then click the Properties or Preferences button. The Print TasksQuick Sets drop-down list appears on all tabs except the Services tab.
 2. In the Print Tasks Quick Sets drop-down list , select one of the quick sets, and then click OK toprint the job with the predefined settings.
 Create a custom printing quick set
 1. Open the printer driver, and then click the Properties or Preferences button. The Print TasksQuick Sets drop-down list appears on all tabs except the Services tab.
 2. Select an existing quick set as a base.
 3. Select the print options for the new quick set.
 4. Click Save As, type a name for the quick set, and then click OK.
 Improve print quality with Windows
 Select a page size
 1. Open the printer driver, click the Properties or Preferences button, and then click the Paper/Quality tab.
 2. Select a size from the Size is drop-down list.
 3. Click the OK button.
 Select a custom page size
 1. Open the printer driver, and then click the Paper/Quality tab.
 2. Click the Custom button. The Custom Paper Size dialog box opens.
 3. Type a name for the custom size, specify the dimensions, and then click Save.
 4. Click the Close button, and then click the OK button.
 Select a paper type
 1. Open the printer driver, click the Properties or Preferences button, and then click the Paper/Quality tab.
 2. Select a type from the Type is drop-down list.
 3. Click the OK button.
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Select the print resolution
 1. Open the printer driver, click the Properties or Preferences button, and then click the Paper/Quality tab.
 2. In the Print Quality area, select an option from the drop-down list. See the printer-driver onlineHelp for information about each of the available options.
 NOTE: To use a draft-quality resolution, in the Print Quality area, click the EconoModecheck box.
 3. Click the OK button.
 Print the first or last page on different paper with Windows
 1. Open the printer driver, click the Properties or Preferences button, and then click the Paper/Quality tab.
 2. Click the Use Different Paper/Covers check box, and then select the necessary settings forthe front cover, other pages, and back cover.
 3. Click the OK button.
 Scale a document to fit page size with Windows
 1. Open the printer driver, click the Properties or Preferences button, and then click the Effectstab.
 2. Click the Print document on check box, and then select a size from the drop-down list.
 3. Click the OK button.
 Add a watermark to a document with Windows
 1. Open the printer driver, click the Properties or Preferences button, and then click the Effectstab.
 2. Select a watermark from the Watermarks drop-down list.
 To print the watermark on the first page only, click the First page only check box. Otherwise,the watermark is printed on each page.
 3. Click the OK button.
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Print on both sides (duplex) with Windows
 Manually print on both sides (duplex)
 1. Load paper face-up in the input tray.
 2. Open the printer driver, and then click the Properties or Preferences button.
 3. Click the Finishing tab.
 4. Click the Print On Both Sides (manually) check box. If you will bind the document along thetop edge, click the Flip pages up check box.
 5. Click the OK button to print the first side of the job.
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6. Retrieve the printed stack from the output bin, and, maintaining the paper orientation, place it withthe printed-side facing down in the input tray.
 7. At the computer, click the Continue button to print the second side of the job.
 Create a booklet with Windows
 1. Open the printer driver, click the Properties or Preferences button, and then click theFinishing tab.
 2. Click the Print on both sides (manually) check box.
 3. In the Booklet layout drop-down list, click the Left binding or Right binding option. ThePages per sheet option automatically changes to 2 pages per sheet.
 4. Click the OK button.
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Print multiple pages per sheet with Windows
 1. Open the printer driver, click the Properties or Preferences button, and then click theFinishing tab.
 2. Select the number of pages per sheet from the Pages per sheet drop-down list.
 3. Select the correct options for Print Page Borders, Page Order, and Orientation.
 4. Click the OK button.
 Select page orientation with Windows
 1. Open the printer driver, click the Properties or Preferences button, and then click theFinishing tab.
 2. In the Orientation area, select the Portrait or Landscape option.
 To print the page image upside down, select the Rotate by 180 degrees option.
 3. Click the OK button.
 Use HP ePrint
 HP ePrint is a suite of Web-based printing services that enable a supported HP product to printdocuments of the following types:
 ● E-mail messages and attachments sent directly to the HP product’s e-mail address
 ● Documents from select mobile device print applications
 Use HP Cloud Print
 Use HP Cloud Print to print e-mail messages and attachments by sending them to the product's e-mailaddress from any e-mail enabled device.
 NOTE: The product must be connected to a wired or wireless network. To use HP Cloud Print, youmust first have access to the Internet and enable HP Web Services.
 1. Enable HP Web Services in the HP Embedded Web Server (EWS) by following these steps:
 a. After the product is connected to the network, print a configuration page and identify theproduct IP address.
 b. At your computer, open a Web browser and enter the product IP address into the addressline. The HP EWS appears.
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c. Click the HP Web Services tab. If your network does not use a proxy server to access theInternet, proceed to the next step. If your network uses a proxy server to access the Internet,follow these instructions before proceeding to the next step:
 i. Select the Proxy Settings tab.
 ii. Select the Check this box if your network uses a proxy server to accessthe Internet check box.
 iii. In the Proxy Server field, enter the proxy server address and port number, and thenclick the Apply button.
 d. Select the HP Web Services tab and click the Enable button. The product configures theconnection to the Internet, and then a message appears informing you that an informationsheet will be printed.
 e. Click the OK button. An ePrint page prints out. On the ePrint page, look for the e-mailaddress that is automatically assigned to the product.
 2. To print a document, attach it to an e-mail message, and then send the message to the product's e-mail address. Go to www.hpeprintcenter.com for a list of supported document types
 3. Optionally, use the HP ePrintCenter Web site to define security settings and to configure defaultprint settings for all HP ePrint jobs sent to this product:
 a. Open a Web browser and go to www.hpeprintcenter.com.
 b. Click Sign In, and enter your HP ePrintCenter credentials or sign up for a new account.
 c. Select your product from the list, or click the + Add printer button to add it. To add theproduct, you need the product code, which is the segment of the product e-mail address thatis before the @ symbol.
 NOTE: This code is valid for only 24 hours from the time you enable HP Web Services. If itexpires, follow the instructions to enable HP Web Services again, and obtain a new code.
 d. Click the Setup button. The HP ePrint Settings dialog box appears. Three tabs areavailable:
 ● Allowed Senders. To prevent your product from printing unexpected documents, clickthe Allowed Senders tab. Click Allowed Senders Only, and then add the e-mailaddresses from which you want to allow ePrint jobs.
 ● Print Options. To set up default settings for all ePrint jobs sent to this product, click thePrint Options tab, and then select the settings that you want to use.
 ● Advanced. To change the product’s e-mail address, click the Advanced tab.
 Use HP Direct Print (wireless models only)
 Use HP Direct Print to print directly to the product from any mobile device (such as a smart phone, netbook, or laptop computer).
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NOTE: No setup is necessary, but HP Direct Print must be enabled. Your mobile device must have anHP print application installed.
 The HP LaserJet Professional P1102w model does not support HP Direct Print.
 1. To enable HP Direct Print, follow these steps:
 a. After the product is connected to the network, print a configuration page and identify theproduct IP address.
 b. At your computer, open a Web browser and enter the product IP address into the addressline. The HP EWS screen appears.
 c. Click the Networking tab.
 d. On the Networking page, click Wireless Direct Setup. Select the check box, enter thenetwork name (SSID) in the Wireless Direct Printing Name (SSID) field, and then clickthe Apply button. The IP address of the mobile device appears in the Networking page.
 NOTE: To find the network name (SSID), click the Wireless Configuration menu in theNetworking page.
 2. To print a document from an application, select File, and then select Print.
 NOTE: If only one product that supports HP Direct Print is connected to the wireless network, thedocument prints. If more than one product that supports HP Direct Print is connected, a list ofproducts appears; you must select your product before proceeding to the next step. If no product isdiscovered, follow the instructions in step 1 to connect the product.
 Use AirPrint
 Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly tothe product from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) inthe following applications:
 ● Mail
 ● Photos
 ● Safari
 ● Select third-party applications
 NOTE: The product must be connected to a wired or wireless network.
 52 Chapter 6 Print tasks ENWW

Page 67
                        

To print, follow these steps:
 1.Tap the action item.
 2. Tap Print.
 NOTE: If you are printing for the first time, or if your previously selected product is notavailable, you must select a product before proceeding to the next step.
 3. Configure the print options and then tap Print.
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7 Manage and maintain the product
 ● Print the information pages
 ● Use the HP Embedded Web Server (wireless models only)
 ● Economy settings
 ● Manage supplies and accessories
 ● Clean the product
 ● Product updates
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Print the information pagesYou can print the following information pages.
 Configuration page
 The configuration page lists current product settings and properties. It also contains a status log report.To print a configuration page, do the following:
 1. Open the printer driver, and then click the Properties or Preferences button.
 2. Click the Services tab, and then, in the Print Information Pages drop-down list, click theConfig Page list item.
 3. Click the Print button.
 On wireless models, you can print the configuration page from the product control panel.
 ▲ At the control panel, press and hold the cancel button until the ready light starts blinking,and then release the button.
 Supplies status page
 To print the supplies status page, select it from the Print Information Pages drop-down on theServices tab in the printer driver. The supplies status page provides the following information:
 ● The estimated percentage of toner remaining in the print cartridge
 ● The number of pages and print jobs that have been processed
 ● Ordering and recycling information
 Demo page
 To print the demo page, select it from the Print Information Pages drop-down on the Services tabin the printer driver. The demo page contains examples of text and graphics, and is used to showproduct print quality.
 56 Chapter 7 Manage and maintain the product ENWW

Page 71
                        

Use the HP Embedded Web Server (wireless modelsonly)
 Use the HP Embedded Web Server (EWS) to view product and network status and to manage printingfunctions from a computer.
 ● View product status information
 ● Determine the remaining life on all supplies and order new ones
 ● View and change the product default configuration settings
 ● View and change network configuration
 You do not need to install any software on the computer. You only need to use one of these supportedWeb browsers:
 ● Internet Explorer 6.0 (and later)
 ● Firefox 1.0 (and later)
 ● Mozilla 1.6 (and later)
 ● Opera 7.0 (and later)
 ● Safari 1.2 (and later)
 ● Konqueror 3.2 (and later)
 The HP Embedded Web Server works when the product is connected to a TCP/IP-based network. TheHP Embedded Web Server does not support IPX-based connections or direct USB connections.
 NOTE: You do not have to have Internet access to open and use the HP Embedded Web Server.However, if you click a link on any of the pages, you must have Internet access to go to the siteassociated with the link.
 Open the HP Embedded Web Server by using a networkconnection
 To open the HP Embedded Web Server, type the IP address or host name of the product in the addressfield of a supported Web browser. To find the IP address, print a configuration page at the product bypressing and holding the cancel button when the ready light is on and no other jobs are printing.Hold the button until the ready light starts blinking.
 TIP: After you open the URL, bookmark it so that you can return to it quickly in the future.
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HP Embedded Web Server sections
 Information tab
 The Information pages group consists of the following pages:
 ● Device Status displays the status of the product and HP supplies.
 ● Device Configuration shows the information found on the Configuration page.
 ● Supplies Status shows the status of HP supplies and provides part numbers. To order newsupplies, click Order Supplies in the upper-right part of the window.
 ● Network Summary shows the information found on the Network Summary page.
 Settings tab
 Use this tab to configure the product from your computer. If this product is networked, always consultwith the product administrator before changing settings on this tab.
 The Settings tab contains the Printing page where you can view and change the default print jobsettings.
 Networking tab
 Network administrators can use this tab to control network-related settings for the product when it isconnected to an IP-based network.
 HP Smart Install tab
 NOTE: This tab is supported for Windows only.
 Use this tab to install the product driver and software on a computer. Click the Download button tostart the installation process, and then follow the onscreen instructions to finish the process.
 Links
 Links are located in the upper-right part of the status pages. You must have Internet access to use any ofthese links. If you use a dial-up connection and did not connect when you first opened theHP Embedded Web Server, you must connect before you can visit these Web sites. Connecting mightrequire that you close the HP Embedded Web Server and reopen it.
 ● Shop for Supplies. Click this link to connect to the Sure Supply Web site and order genuineHP supplies from HP or a reseller of your choice.
 ● Support. Connects to the product support site. You can search for help regarding general topics.
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Economy settings
 Auto-Off mode
 Auto-Off is an energy-saving feature of this product. After a user-specified time period, the productautomatically reduces its power consumption (Auto-Off). The product returns to the ready state when abutton is pressed or a print job is received. When the product is in Auto-Off mode, all of the control-panel LEDs and the power button backlight LED are off.
 NOTE: Although the product lights are off in Auto-Off mode, the product will work normally when itreceives a print job.
 Change the Auto-Off delay time
 You can change how long the product remains idle (Auto-Off delay) before it enters Auto-Off mode.
 NOTE: The default Auto-Off delay setting is 5 minutes.
 1. Open the printer properties, and then click the Device Settings tab.
 2. Select the Auto-Off delay from the Auto-Off drop-down list.
 NOTE: The changed setting does not go into effect until a print job is sent to product.
 Print with EconoMode
 This product has an EconoMode option for printing drafts of documents. Using EconoMode can use lesstoner and decrease the cost per page. However, using EconoMode can also reduce print quality.
 HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the tonersupply might outlast the mechanical parts in the print cartridge. If print quality begins to degrade underthese circumstances, you must install a new print cartridge, even if there is toner supply remaining inthe cartridge.
 Enable EconoMode with Windows
 1. Open the printer driver, and then click the Properties or Preferences button.
 2. Click the Paper/Quality tab.
 3. Click the EconoMode check box.
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Manage supplies and accessoriesCorrectly using, storing, and monitoring the print cartridge can help ensure high-quality print output.
 Check and order supplies
 Print-cartridge storage
 Do not remove the print cartridge from its package until you are ready to use it.
 CAUTION: To prevent damage to the print cartridge, do not expose it to light for more than a fewminutes.
 HP policy on non-HP print cartridges
 Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new orremanufactured.
 NOTE: Any damage caused by a non-HP print cartridge is not covered under the HP warranty andservice agreements.
 To install a new genuine HP print cartridge, see Replace the print cartridge on page 62.
 HP fraud hotline and Web site
 Call the HP fraud hotline (1-877-219-3183, toll-free in North America) or go to www.hp.com/go/anticounterfeit when you install an HP print cartridge and the control-panel message says the cartridgeis non-HP. HP will help determine if the cartridge is genuine and take steps to resolve the problem.
 Your print cartridge might not be a genuine HP print cartridge if you notice the following:
 ● You are experiencing a high number of problems with the print cartridge.
 ● The cartridge does not look like it usually does (for example, the orange pull tab is missing, or thepackaging differs from HP packaging).
 Recycle supplies
 To recycle a genuine HP print cartridge, place the used cartridge in the box in which the new cartridgearrived. Use the enclosed return label to send the used supply to HP for recycling. For completeinformation, see the recycling guide that is included with each new HP supply item.
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Replacement instructions
 Redistribute toner
 When a small amount of toner remains in print cartridge, faded or light areas might appear on theprinted page. You might be able to temporarily improve print quality by redistributing the toner.
 1. Open the print-cartridge door, and then remove the print cartridge.
 2. To redistribute the toner, gently rock the print cartridge from front to back.
 CAUTION: If toner gets on your clothing, wipe it off with a dry cloth and wash the clothing incold water. Hot water sets toner into the fabric.
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3. Reinsert the print cartridge into the product, and then close the print-cartridge door.
 If the print is still light, install a new print cartridge.
 Replace the print cartridge
 When a print cartridge approaches the end of useful life, you can continue printing with the currentcartridge until redistributing the toner no longer yields acceptable print quality.
 1. Open the print-cartridge door, and then remove the old print cartridge.
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2. Remove the new print cartridge from the packaging. Place the used print cartridge in the bag andbox for recycling.
 CAUTION: To prevent damage to the print cartridge, hold the print cartridge at each end. Donot touch the cartridge shutter or the roller surface.
 3. Grasp both sides of the print cartridge and gently rock the print cartridge to distribute the tonerevenly inside the cartridge.
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4. Bend the tab on the left side of the cartridge until the tab breaks loose, and then pull the tab untilall the tape is removed from the cartridge. Place the tab and tape in the print-cartridge box toreturn for recycling.
 5. Insert the print cartridge in the product, and then close the print-cartridge door.
 CAUTION: If toner gets on your clothing, wipe it off with a dry cloth and wash the clothing incold water. Hot water sets toner into the fabric.
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Replace the pickup roller
 Normal use with good media causes wear. The use of poor media might require more frequentreplacement of the pickup roller.
 If the product regularly mispicks (no media feeds through), you might need to change or clean thepickup roller. See Clean the pickup roller on page 71 to order a new pickup roller.
 1. Open the print-cartridge door, and then remove the print cartridge.
 CAUTION: To prevent damage to the print cartridge, minimize its exposure to direct light.Cover the print cartridge with a sheet of paper.
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2. Find the pickup roller.
 3. Release the small, white tabs on each side of the pickup roller, and rotate the pickup roller towardthe front.
 4. Gently pull the pickup roller up and out.
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5. Position the new pickup roller in the slot. The circular and rectangular slots on each side preventsyou from installing the roller incorrectly.
 6. Rotate the top of the new pickup roller away from you until both sides snap into place.
 7. Insert the print cartridge in the product, and then close the print-cartridge door.
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Replace the separation pad
 Normal use with good media causes wear. The use of poor media might require more frequentreplacement of the separation pad.
 If the product regularly pulls multiple sheets of media at a time, you might need to change theseparation pad.
 NOTE: Before you change the separation pad, clean the pickup roller. See Clean the pickup rolleron page 71.
 WARNING! Before changing the separation pad, turn the product off, disconnect the power cordfrom the wall outlet, and then wait for the product to cool.
 1. Disconnect the product power cord from the product.
 2. Remove the paper and close the input tray. Set the product on its front.
 3. At the bottom of the product, unscrew the two screws holding the separation pad in place.
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4. Remove the separation pad.
 5. Insert the new separation pad, and screw it into place.
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6. Reconnect the power cord, and then turn on the product.
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Clean the product
 Clean the pickup roller
 If you want to clean the pickup roller before deciding to replace it, follow these instructions:
 1. Unplug the power cord from the product and remove the pickup roller as described in Replace thepickup roller on page 65.
 2. Dab a lint-free cloth in isopropyl alcohol, and scrub the roller.
 WARNING! Alcohol is flammable. Keep the alcohol and cloth away from an open flame.Before you close the product and plug in the power cord, allow the alcohol to dry completely.
 NOTE: In certain areas of California, air pollution control regulations restrict the use of liquidIsopropyl Alcohol (IPA) as a cleaning agent. In those areas of California, please disregard theprevious recommendations and use a dry, lint-free cloth, moistened with water, to clean the pickuproller.
 3. Using a dry, lint-free cloth, wipe the pickup roller to remove loosened dirt.
 4. Allow the pickup roller to dry completely before you reinstall it in the product.
 5. Reconnect the power cord.
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Clean the paper path
 If you are experiencing toner specks or dots on the printouts, clean the paper path. This process uses atransparency to remove dust and toner from the paper path. Do not use bond or rough paper.
 NOTE: For best results use a sheet of transparency. If you do not have any transparencies, you canuse copier-grade media (60 to 163 g/m2 (16 to 43 lb)) that has a smooth surface.
 1. Make sure that the product is idle and the ready light is on.
 2. Load media in the input tray.
 3. Open the printer Properties.
 4. Click the Device Settings tab.
 5. In the Cleaning Page area, click the Start button to process the cleaning page.
 NOTE: The cleaning process takes about 2 minutes. The cleaning page stops periodically during thecleaning process. Do not turn the product off until the cleaning process has finished. You might need torepeat the cleaning process several times to thoroughly clean the product.
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Clean the print-cartridge area
 You do not need to clean the print-cartridge area often. However, cleaning this area can improve thequality of the printed sheets.
 WARNING! Before changing the separation pad, turn the product off, disconnect the power cordfrom the wall outlet, and then wait for the product to cool.
 1. Disconnect the power cord from the product. Open the print-cartridge door, and then remove theprint cartridge.
 CAUTION: Do not touch the black-sponge transfer roller inside the product. Doing so candamage the product.
 CAUTION: To prevent damage, do not expose the print cartridge to light. Cover it with a pieceof paper.
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2. With a dry, lint-free cloth, wipe any residue from the paper-path area and the print-cartridgecavity.
 3. Reinstall the print cartridge, and then close the print-cartridge door.
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4. Disconnect the power cord.
 Clean the exterior
 Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the exterior of the device.
 Product updatesSoftware and firmware updates and installation instructions for this product are available atwww.hp.com/support/ljp1100series. Click Downloads and drivers, click the operating system,and then select the download for the product.
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8 Solve problems
 ● Solve general problems
 ● Interpret control-panel light patterns
 ● Clear jams
 ● Solve paper-handling problems
 ● Solve image-quality problems
 ● Solve performance problems
 ● Solve connectivity problems
 ● Solve product software problems
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Solve general problemsIf the product is not responding correctly, complete the steps in the following checklist, in order. If theproduct does not pass a step, follow the corresponding troubleshooting suggestions. If a step resolvesthe problem, you can stop without performing the other steps on the checklist.
 Troubleshooting checklist
 1. Make sure that the product is set up correctly.
 a. Press the power button to turn on the product or to deactivate the Auto-Off mode.
 b. Check the power-cable connections.
 c. Make sure that the line voltage is correct for the product power configuration. (See the labelthat is on the back of the product for voltage requirements.) If you are using a power stripand its voltage is not within specifications, plug the product directly into the wall. If it isalready plugged into the wall, try a different outlet.
 d. Make sure that the print cartridge is installed correctly.
 e. If none of these measures restores power, contact HP Customer Care.
 2. Check the cabling or wireless connection (wireless models only).
 a. Check the cable connection between the product and the computer. Make sure that theconnection is secure.
 b. Make sure that the cable itself is not faulty by using a different cable, if possible.
 c. For a wireless connection, look at the control panel wireless light.
 ● If the light is on, the product has a connection with a network.
 ● If the light is blinking, the product is searching for a network connection. Make sure thatthe wireless router or access point and the product are set to use the same mode orprotocol.
 ● If the light is off, the product is not connected to the network and the wireless unit in theproduct might be off. Press the wireless button to try connecting to the network, or runthe Wireless Configuration utility to configure the product. See Use the WirelessConfiguration utility on page 31. To verify that the product finds the network, print aconfiguration page. The product should have an IP address assigned to it.
 If the product remains unable to connect to the network, uninstall and then reinstall theproduct. If the error persists, contact a network administrator or refer to the user manual ofthe wireless router or access point.
 3. Check to see if any control-panel lights are lit. See Interpret control-panel light patternson page 80.
 4. Make sure that the paper that you are using meets specifications.
 5. Make sure that the paper is loaded correctly in the input tray.
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6. Make sure that the product software is installed correctly.
 7. Verify that you have installed the printer driver for this product. Check the program to make surethat you are using the printer driver for this product.
 8. Print a configuration page. See Print the information pages on page 56.
 a. If the page does not print, verify that the input tray contains paper.
 b. If the page jams in the product, see Clear jams on page 83.
 9. Print a small document from a different program that has worked in the past. If this solution works,then the problem is with the program you are using. If this solution does not work (the documentdoes not print), complete these steps:
 a. Try printing the job from another computer that has the product software installed.
 b. Check the USB cable connection. Direct the product to the correct port, or reinstall thesoftware, selecting the connection type that you are using.
 c. If the print quality is unacceptable, complete the following steps:
 ● Verify that the print settings are correct for the media that you are using. See Changethe print driver to match the media type and size on page 36.
 ● Use the procedures in Solve image-quality problems on page 93 to solve print-qualityproblems.
 Factors that affect product performance
 Several factors affect the time it takes to print a job:
 ● The use of special paper (such as transparencies, heavy paper, and custom-size paper)
 ● Product processing and download time
 ● The complexity and size of graphics
 ● The speed of the computer you are using
 ● The USB or network connection
 ● The product I/O configuration
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Interpret control-panel light patternsTable 8-1 Status-light legend
 Symbol for "light off"
 Symbol for "light on"
 Symbol for "light blinking"
 Table 8-2 Control-panel light patterns
 Light status State of the product Action
 All lights are off. The product is in Auto-Off mode or isturned off.
 Press the power button to deactivate theAuto-Off mode or to turn on the product.
 Status lights cycle The status lights cycle during the formatterinitialization period or when the productis processing a cleaning page.
 No action is required. Wait for theinitialization period to end. The productshould enter the ready state when theinitialization period is finished.
 Ready light is on, and attention light isoff.
 The product is in the ready state. No action is required. The product isready to receive a print job.
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Table 8-2 Control-panel light patterns (continued)
 Light status State of the product Action
 Ready light is blinking, and attentionlight is off.
 The product is receiving or processingdata.
 No action is required. The product isreceiving or processing a print job.
 Attention light is blinking, and readylight is off.
 The product has experienced an errorthat can be corrected at the product, suchas a jam, an open door, the absence ofa print cartridge, or the absence of paperin the proper tray.
 Inspect the product, determine the error,and then correct the error. If the error isthe absence of paper in the proper trayor the product is in a manual feed mode,put the proper paper in the tray andfollow the onscreen instructions, or openand close the print-cartridge door toresume printing.
 Attention light is blinking, and readylight is on.
 The product has experienced a continualerror from which it will recover on itsown.
 If the recovery is successful, the productcontinues to the processing data stateand completes the job.
 If the recovery is unsuccessful, theproduct continues to the continuableerror state. Try removing any media fromthe media path and turning the productpower off, and then on again.
 The attention and ready lights are on. The product has experienced a fatal errorfrom which it cannot recover.
 1. Turn off the product or disconnectthe power cord from the product.
 2. Wait 30 seconds, and then turn onthe product or reconnect the powercord to the product.
 3. Wait for the product to initialize.
 If the error persists, contact HP customersupport. See Customer supporton page 115.
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Table 8-2 Control-panel light patterns (continued)
 Light status State of the product Action
 The wireless light is blinking. The product is attempting to locate awireless network.
 No action is required.
 The wireless light is on. The product is connected to a wirelessnetwork.
 No action is required.
 The wireless light is off. The product is not connected to anetwork, and the wireless unit in theproduct might be turned off.
 If the light is off, the product is notconnected to the network and thewireless unit in the product might be off.Press the wireless button to tryconnecting to the network, or run theWireless Configuration utility toconfigure the product. See Use theWireless Configuration utilityon page 31. To verify that the productfinds the network, print a configurationpage. The product should have an IPaddress assigned to it.
 For information about connectingwirelessly to a network, see Networkconnection (wireless models only)on page 28.
 If the product remains unable to connectto the network, uninstall and thenreinstall the product. If the error persists,contact a network administrator or referto the user manual of the wireless routeror access point.
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Clear jamsWhen clearing jams, be careful not to tear jammed paper. If a small piece of paper remains in theproduct, it could cause additional jams.
 Common causes of jams
 ● The input tray is loaded incorrectly or is too full.
 NOTE: When you add new media, always remove all of the media from the input tray andstraighten the entire stack. This helps prevent multiple feeds and reduces media jams.
 ● The media does not meet HP specifications.
 ● The product might need to be cleaned to remove paper dust and other particles from the paperpath.
 Loose toner might remain in the product after a media jam. This toner clears up after a few sheets print.
 CAUTION: If you get any toner on your clothes, wash them in cold water. Hot water willpermanently set the toner into the fabric.
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Jam locations
 Jams can occur at the following locations in the product.
 2
 31
 1 Internal areas
 2 Input tray
 3 Output bin
 NOTE: Jams can occur in more than one location.
 Clear jams from the input tray
 CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.Damage caused by sharp objects will not be covered by the warranty.
 When removing jammed media, pull the jammed media straight away from the product. Pullingjammed media out of the product at an angle can damage the product.
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NOTE: Depending on where the jam is located, some of the following steps might not be necessary.
 1. Open the print-cartridge door, and then remove the print cartridge.
 2. Remove the media stack from the input tray.
 ENWW Clear jams 85

Page 100
                        

3. With both hands, grasp the side of the jammed media that is most visible (this includes themiddle), and carefully pull it free from the product.
 4. Reinstall the print cartridge, and then close the print-cartridge door.
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Clear jams from the output areas
 CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.Damage caused by sharp objects will not be covered by the warranty.
 1. Open the print-cartridge door, and then remove the print cartridge.
 2. Keep the print cartridge door open, and then with both hands, grasp the side of the jammedmedia that is most visible (this includes the middle), and carefully pull it free from the product.
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3. Reinstall the print cartridge, and then close the print-cartridge door.
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Clear jams from inside the product
 1. Open the print-cartridge door, and then remove the print cartridge.
 CAUTION: To prevent damage, do not expose the print cartridge to light. Cover it with a pieceof paper.
 2. If you can see the jammed paper, carefully grasp the jammed paper, and slowly pull it out of theproduct.
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3. Reinstall the print cartridge, and then close the print-cartridge door.
 Solve repeated jams
 ● Verify that the input tray is not overfilled. The input tray capacity varies depending on the type ofprint media that you are using.
 ● Verify that the media guides are properly adjusted.
 ● Check that the input tray is securely in place.
 ● Do not add print media into the input tray while the product is printing.
 ● Use only HP-recommended media types and sizes.
 ● Do not fan media prior to loading it in a tray. To loosen the ream, hold it firmly in both hands andtwist the media by rotating your hands in the opposite direction.
 ● Do not let print media stack up in the output bin. The print media type and the amount of tonerused affect the output bin capacity.
 ● Check the power connection. Make sure that the power cord is firmly connected to both theproduct and the power supply box. Plug the power cord into a grounded power outlet.
 Change the jam recovery setting
 When the Jam Recovery feature is turned on, the product reprints any pages that are damaged duringa jam.
 1. Open the product Properties dialog box.
 2. Click the Device Settings tab.
 3. Click the Auto option or the Off option under Jam Recovery.
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Solve paper-handling problemsThe following problems with media cause print-quality deviations, jamming, or damage to the product.
 Problem Cause Solution
 Poor print quality or toner adhesion The paper is too moist, too rough, tooheavy or too smooth, or it is embossedor from a faulty paper lot.
 Try another kind of paper, between 100and 250 Sheffield, with 4% to 6%moisture content.
 Dropouts, jamming, or curl The paper has been stored incorrectly. Store paper flat in its moisture-proofwrapping.
 The paper has variability from one sideto the other.
 Turn the paper over.
 Excessive curl The paper is too moist, has the wronggrain direction, or is of short-grainconstruction
 Use long-grain paper.
 The paper varies from side-to-side. Turn the paper over.
 Jamming, damage to product The paper has cutouts or perforations. Use paper that is free of cutouts orperforations.
 Problems with feeding The paper has ragged edges. Use high-quality paper that is made forlaser printers.
 The paper varies from side-to-side. Turn the paper over.
 The paper is too moist, too rough, tooheavy or too smooth, has the wronggrain direction, or is of short-grainconstruction or it is embossed or from afaulty paper lot.
 Try another kind of paper, between 100and 250 Sheffield, 4% to 6% moisturecontent.
 Use long-grain paper.
 Print is skewed (crooked). The media guides might be incorrectlyadjusted.
 Remove all media from the input tray,straighten the stack, and then load themedia in the input tray again. Adjust themedia guides to the width and length ofthe media that you are using and tryprinting again.
 More than one sheet feeds at one time. The media tray might be overloaded. Remove some of the media from thetray.
 The media might be wrinkled, folded, ordamaged.
 Verify that the media is not wrinkled,folded, or damaged. Try printing onmedia from a new or different package.
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Problem Cause Solution
 The product does not pull media fromthe input tray.
 The product might be in manual-feedmode.
 At the computer, follow the onscreeninstructions to deactivate manual-feedmode. Or, at the product, open andclose the print-cartridge door.
 The pickup roller might be dirty ordamaged.
 Contact HP Customer Care. See Serviceand support on page 109 or thesupport flyer that came in the box.
 The paper-length adjustment control inthe input tray is set at a length that isgreater than the media size.
 Set the paper-length adjustment controlto the correct length.
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Solve image-quality problemsYou can prevent most print-quality problems by following these guidelines.
 ● Use paper that meets HP specifications. See Paper and print media on page 33.
 ● Clean the product as necessary. See Clean the product on page 71.
 Image defect examples
 This section provides information about identifying and correcting print defects.
 NOTE: If these steps do not correct the problem, contact an HP-authorized dealer or servicerepresentative.
 Light print or faded
 ● Redistribute the toner to extend the life. See Redistributetoner on page 61.
 ● The print cartridge is nearing end of life. Install a newgenuine HP print cartridge.
 ● The media might not meet Hewlett-Packard's mediaspecifications (for example, the media is too moist or toorough).
 ● If the whole page is light, the print density adjustment istoo light or EconoMode might be turned on. Adjust theprint density, and disable EconoMode in the productProperties.
 Toner specks
 ● The media might not meet Hewlett-Packard's mediaspecifications (for example, the media is too moist or toorough).
 ● The product might need to be cleaned.
 ● The print cartridge might be defective. Install a newgenuine HP print cartridge.
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Dropouts
 ● A single sheet of media might be defective. Try reprintingthe job.
 ● The media moisture content is uneven or the media hasmoist spots on its surface. Try printing with new media.
 ● The media lot is bad. The manufacturing processes cancause some areas to reject toner. Try a different type orbrand of media.
 ● The print cartridge might be defective. Install a newgenuine HP print cartridge.
 Vertical lines
 ● Toner might be on the photosensitive drum. Print a fewmore pages to see if the problem might correct itself.
 ● The photosensitive drum inside the print cartridge hasprobably been scratched. Install a new genuine HP printcartridge.
 Gray background
 ● Change the media to a lighter basis weight.
 ● Check the product environment. Very dry (low humidity)conditions can increase the amount of backgroundshading.
 ● The density setting might be too high. Adjust the densitysetting. See Change print density on page 98
 ● Install a new genuine HP print cartridge.
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Toner smear
 ● If toner smears appear on the leading edge of themedia, the media guides might be dirty. Wipe the mediaguides with a dry, lint-free cloth.
 ● Check the media type and quality.
 ● The fuser temperature might be too low. In the printerdriver, make sure the appropriate media type is selected.
 ● Try installing a new genuine HP print cartridge.
 Loose toner
 ● The fuser temperature might be too low. In the printerdriver, make sure the appropriate media type is selected.
 ● Clean the inside of the product. See Clean the producton page 71.
 ● Check the media quality.
 ● Plug the product directly into an AC outlet instead of intoa power strip.
 Vertical repetitive defects
 ● The print cartridge might be damaged. If a repetitivemark occurs at the same spot on the page, install a newgenuine HP print cartridge.
 ● The internal parts might have toner on them. If the defectsoccur on the back of the page, the problem probablywill correct itself after a few more printed pages.
 ● In the printer driver, make sure the appropriate mediatype is selected.
 Misformed characters
 ● If characters are improperly formed, producing hollowimages, the media stock might be too slick. Try adifferent media.
 ● If characters are improperly formed, producing a wavyeffect, the product might need service. Print aconfiguration page. If the characters are improperlyformed, contact an HP-authorized dealer or servicerepresentative.
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Page skew
 ● Make sure that the media is loaded correctly and themedia guides are not too tight or too loose against themedia stack.
 ● The input bin might be too full.
 ● Check the media type and quality.
 Curl or wave
 ● Check the media type and quality. Both high temperatureand high humidity cause media to curl.
 ● The media might have been in the input tray too long.Turn over the stack of media in the tray. Also, try rotatingthe media 180° in the input tray.
 ● The fuser temperature might be too high. In the printerdriver, make sure that the appropriate media type isselected. If the problem persists, select a media type thatuses a lower fuser temperature, such as transparencies orlight media.
 Wrinkles or creases
 ● Make sure that media is loaded properly.
 ● Check the media type and quality.
 ● Turn over the stack of media in the tray. Also, try rotatingthe media 180° in the input tray.
 ● For envelopes, this can be caused by air pockets insidethe envelope. Remove the envelope, flatten the envelope,and then try printing again.
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Toner scatter outline
 ● If large amounts of toner have scattered around thecharacters, the transfer of toner to the media is notoptimal. (A small amount of toner scatter is normal forlaser printing.) Try a different media type setting in theprinter driver, or use a different media type.
 ● Turn over the stack of media in the tray.
 ● Use media that is designed for laser printers.
 Moisture
 NOTE: This product dissipates heat by using convectivecooling. The heat and moisture generated by the printingprocess escape through vents in the product exterior orthrough the output bin area.
 Verify normal product operation
 The release of moisture is a result of normal productoperation. However, HP recommends using the followingsteps to verify that the product is releasing steam and does nothave a functional problem.
 1. Turn the product off, and then on.
 2. Send a print job to the product, and then verify that theproduct is operating correctly.
 3. When printing a job and vapor is visible, immediatelyreprint the job using the same sheet of paper. Thereshould be either no visible vapor, or much less vaporduring the printing process.
 Limit or reduce steam or vapor
 ● Make sure that the product is placed in a well-ventilatedarea that meets the environmental specifications in thisguide. See Environmental specifications on page 118.
 ● Do not place the product, or store paper, near anoutside entrance where temperature changes canincrease humidity.
 ● Use an unopened ream of paper that has not beenexposed to high humidity.
 ● Store paper in an airtight container, where it will be lesslikely to absorb moisture.
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Optimize and improve image quality
 Change print density
 You can change the print density setting by from the printer properties dialog box.
 1. Windows XP, Windows Server 2008, and Windows Server 2003 (using thedefault Start menu view): Click Start, and then click Printers and Faxes.
 -or-
 Windows XP, Windows Server 2008, and Windows Server 2003 (using theClassic Start menu view): Click Start, and then click Printers.
 -or-
 Windows Vista: Click Start, click Control Panel, and then in the category for Hardwareand Sound click Printer.
 2. In the list of printers, right-click the name of this product, and then click the Properties menu itemto open the printer properties dialog box.
 3. Click the Device settings tab, and then move the Print Density slider to the desired setting.
 4. Click the Apply button to accept the setting, and then click the OK button to close the dialogbox.
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Solve performance problems
 Problem Cause Solution
 Pages print but are totally blank. The cartridge pull tab or the sealing tapemight still be in the print cartridge.
 Verify that the cartridge pull tab andtape have been removed completelyfrom the print cartridge.
 The document might contain blankpages.
 Check the document that you areprinting to see if content appears on allof the pages.
 The product might be malfunctioning. To check the product, print aConfiguration page.
 Pages print very slowly. Heavier paper types can slow the printjob.
 Print on a different type of paper.
 Complex pages can print slowly.
 Narrow or small media can print slowly.
 Proper fusing may require a slower printspeed to ensure the best print quality.
 Using the FastRes 1200 print qualitysetting can cause slow printing.
 1. Open the print driver, and thenclick the Properties orPreferences button.
 2. Click the Paper/Quality tab,and then use the Print Qualitydrop-down list to select a lowerresolution setting.
 3. Click the OK button or the Applybutton to accept the setting.
 Pages did not print. The product might not be pulling papercorrectly.
 Make sure that paper is loaded in thetray correctly.
 The paper is jamming in the product. Clear the jam. See Clear jamson page 83.
 The USB cable might be defective orincorrectly connected.
 ● Disconnect the USB cable at bothends, and then reconnect it.
 ● Try printing a job that has printedin the past.
 ● Try using a different USB cable.
 Other devices are running on thecomputer.
 The product might not share a USB port.If you have an external hard drive orswitchbox that is connected to the sameport as the product, the other devicemight be interfering. To connect and usethe product, disconnect the other device,or use two USB ports on the computer.
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Solve connectivity problems
 Solve direct-connect problems
 If you have connected the product directly to a computer, check the USB cable.
 ● Verify that the cable is connected to the computer and to the product.
 ● Verify that the cable is not longer than 2 m (6.56 ft). Replace the cable if necessary.
 ● Verify that the cable is working correctly by connecting it to another product. Replace the cable ifnecessary.
 Solve wireless problems
 The installation program cannot detect the product during the setup process.
 Cause Solution
 The product is off. Verify that the product is on and ready. Restart the product ifnecessary.
 The product is too far away from the wireless router or accesspoint.
 Move the product closer to the wireless router or access point.
 A personal firewall program is blocking communication. Temporarily disable the firewall program to install the product.Re-enable the firewall program once the product installation iscomplete. If disabling the firewall allows you to communicatewith the product, you might want to assign the product a staticIP address, and then re-enable the firewall. For informationabout firewalls that are used in an HP environment, seewww.hp.com/support/XP_firewall_information.
 The product is not communicating with the wireless router oraccess point.
 ● Verify that the wireless light is on. If it is not on, pressthe wireless button.
 ● Move the product closer to the wireless router or accesspoint, and then try again.
 ● Restore the default wireless settings.
 a. Turn the product off.
 b. Press and hold the wireless button and thecancel button, and then turn the product on.
 c. Hold the buttons until all the lights blink in unison,and then release the buttons.
 If the error persists, uninstall the product, and then re-run theinstaller program. When prompted for network settings,provide the settings, and then continue the installation.
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The product cannot connect to the wireless network.
 Cause Solution
 The product wireless settings and the network settings do notmatch.
 You might need to configure the product network settingsmanually. Verify that you know the following network settings:
 ● Communication mode
 ● Network name (SSID)
 ● Channel (ad-hoc networks only)
 ● Authentication type
 Use the Wireless Configuration utility to configure the productto print on wireless network.
 If the error persists, uninstall the product, and then re-run theinstaller program. When prompted for network settings,provide the settings, and then continue the installation.
 The wireless router or access point is configured with a mediaaccess control (MAC) filter that is denying the product accessto the network.
 Configure the wireless router or access point so that the list ofaccepted MAC addresses includes the product hardwareaddress. Refer to the device owners manual for help.
 The wireless connection is sometimes disabled.
 Cause Solution
 The product environment might be affecting wirelesscommunication. The following situations can affect wirelesscommunication:
 ● A concrete or metal framed wall stands between theproduct and the wireless router or access point.
 ● Televisions, computer appliances, microwave ovens,intercoms, mobile/cellular phones, battery chargers, andAC power adapters are installed close to the network.
 ● A broadcast station or high-tension wire is located closeto the network.
 ● A fluorescent light that is near the network is beingswitched on or off.
 Move the product to a location where it can receive a steadysignal from the wireless router or access point. Or you mightneed to move the wireless router or access point.
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Solve product software problems
 Solve common Windows problems
 Error message:
 "General Protection FaultException OE"
 "Spool32"
 "Illegal Operation"
 Cause Solution
 Close all software programs, restart Windows, and try again.
 Delete all temporary files from the Temp subdirectory. To findthe Temp folder, complete the following steps:
 1. Click the Start button, and then click the Run item.
 2. In the Open box, type %temp%.
 3. Click the OK button. A Windows Explorer window forthe Temp folder opens.
 See the Microsoft Windows documentation that came with thecomputer for more information about Windows errormessages.
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Solve common Macintosh problems
 Table 8-3 Problems in Mac OS X
 The printer driver is not listed in the Printer Setup Utility or the Print & Fax list.
 Cause Solution
 The product software might not have been installed or was installedincorrectly.
 Make sure that the product .GZ file is in the following hard-drivefolder:
 ● Mac OS X v10.4: Library/Printers/PPDs/Contents/Resources/<lang>.lproj, where <lang> isthe two-letter language code for the language that you areusing.
 ● Mac OS X v10.5 and v10.6: Library/Printers/PPDs/Contents/Resources
 If necessary, reinstall the software. See the getting started guide forinstructions.
 The Postscript Printer Description (PPD) file is corrupt. Delete the .GZ file from the following hard-drive folder:
 ● Mac OS X v10.4: Library/Printers/PPDs/Contents/Resources/<lang>.lproj, where <lang> isthe two-letter language code for the language that you areusing.
 ● Mac OS X v10.5 and v10.6: Library/Printers/PPDs/Contents/Resources
 Reinstall the software. See the getting started guide for instructions.
 The product name does not appear in the product list in the Printer Setup Utility or Print & Fax list.
 Cause Solution
 The product might not be ready. Make sure that the cables are connected correctly, the product is on,and the ready light is on.
 The wrong product name is being used. Print a configuration page to check the product name. Verify that thename on the configuration page matches the product name in thePrinter Setup Utility or the Print & Fax list.
 The interface cable might be defective or of poor quality. Replace the cable with a high-quality cable.
 The printer driver does not automatically set up the selected product in the Printer Setup Utility or the Print & Faxlist.
 Cause Solution
 The product might not be ready. Make sure that the cables are connected correctly, the product is on,and the ready light is on.
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Table 8-3 Problems in Mac OS X (continued)
 The printer driver does not automatically set up the selected product in the Printer Setup Utility or the Print & Faxlist.
 Cause Solution
 The product software might not have been installed or was installedincorrectly.
 Make sure that the product PPD is in the following hard-drive folder:
 ● Mac OS X v10.4: Library/Printers/PPDs/Contents/Resources/<lang>.lproj, where <lang> isthe two-letter language code for the language that you areusing.
 ● Mac OS X v10.5 and v10.6: Library/Printers/PPDs/Contents/Resources
 If necessary, reinstall the software. See the getting started guide forinstructions.
 The Postscript Printer Description (PPD) file is corrupt. Delete the .GZ file from the following hard-drive folder:
 ● Mac OS X v10.4: Library/Printers/PPDs/Contents/Resources/<lang>.lproj, where <lang> isthe two-letter language code for the language that you areusing.
 ● Mac OS X v10.5 and v10.6: Library/Printers/PPDs/Contents/Resources
 Reinstall the software. See the getting started guide for instructions.
 The interface cable might be defective or of poor quality. Replace the interface cable with a high-quality cable.
 A print job was not sent to the product that you wanted.
 Cause Solution
 The print queue might be stopped. Restart the print queue. Open print monitor and select StartJobs.
 The wrong product name is being used. Another product with thesame or similar name might have received your print job.
 Print a configuration page to check the product name. Verify that thename on the configuration page matches the product name in thePrinter Setup Utility or Print & Fax list.
 You are unable to print from a third-party USB card.
 Cause Solution
 This error occurs when the software for USB products is not installed. When adding a third-party USB card, you might need the AppleUSB Adapter Card Support software. The most current version of thissoftware is available from the Apple Web site.
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When connected with a USB cable, the product does not appear in the Printer Setup Utility or Print & Fax list afterthe driver is selected.
 Cause Solution
 This problem is caused by either a software or a hardwarecomponent.
 Software troubleshooting
 ● Check that your Macintosh supports USB.
 ● Verify that your Macintosh operating system is MacOS X v10.4 or later.
 ● Ensure that your Macintosh has the appropriate USB softwarefrom Apple.
 Hardware troubleshooting
 ● Check that the product is turned on.
 ● Verify that the USB cable is connected correctly.
 ● Check that you are using the appropriate high-speed USBcable.
 ● Ensure that you do not have too many USB devices drawingpower from the chain. Disconnect all of the devices from thechain, and connect the cable directly to the USB port on thehost computer.
 ● Check to see if more than two non-powered USB hubs areconnected in a row on the chain. Disconnect all of the devicesfrom the chain, and then connect the cable directly to the USBport on the host computer.
 NOTE: The iMac keyboard is a non-powered USB hub.
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A Supplies and accessories
 ● Order parts, accessories, and supplies
 ● Part numbers
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Order parts, accessories, and supplies
 Order supplies and paper www.hp.com/go/suresupply
 Order genuine HP parts or accessories www.hp.com/buy/parts
 Order through service or support providers Contact an HP-authorized service or support provider.
 Part numbersThe following list of accessories was current at the time of printing. Ordering information andavailability of the accessories might change during the life of the product.
 Paper-handling accessories
 Item Description Part number
 Pickup roller Pickup roller for input tray RL1-1443-000CN
 Separation pad assembly Separation pad for input tray RM1-4006-000CN
 Print cartridges
 Item Description Part number
 HP LaserJet print cartridge Black print cartridge See one the following items to determinethe print cartridge part number.
 ● The configuration page
 ● The supplies status page
 ● The current print cartridge
 ● www.hp.com/go/ljsupplies
 Cables and interfaces
 Item Description Part number
 USB cable 2-meter A-to-B cable 8121-0868
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B Service and support
 ● Hewlett-Packard limited warranty statement
 ● HP's Premium Protection Warranty: LaserJet print cartridge limited warranty statement
 ● End User License Agreement
 ● Customer self-repair warranty service
 ● Customer support
 ● Repack the product
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Hewlett-Packard limited warranty statement
 HP PRODUCT DURATION OF LIMITED WARRANTY
 HP LaserJet Professional P1100, P1100w One year from date of purchase
 HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defectsin materials and workmanship after the date of purchase, for the period specified above. If HP receivesnotice of such defects during the warranty period, HP will, at its option, either repair or replaceproducts which prove to be defective. Replacement products may be either new or equivalent inperformance to new.
 HP warrants to you that HP software will not fail to execute its programming instructions after the dateof purchase, for the period specified above, due to defects in material and workmanship whenproperly installed and used. If HP receives notice of such defects during the warranty period, HP willreplace software which does not execute its programming instructions due to such defects.
 HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP isunable, within a reasonable time, to repair or replace any product to a condition as warranted, youwill be entitled to a refund of the purchase price upon prompt return of the product.
 HP products may contain remanufactured parts equivalent to new in performance or may have beensubject to incidental use.
 Warranty does not apply to defects resulting from (a) improper or inadequate maintenance orcalibration, (b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorizedmodification or misuse, (d) operation outside of the published environmental specifications for theproduct, or (e) improper site preparation or maintenance.
 TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND NOOTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIEDAND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OFMERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE. Somecountries/regions, states or provinces do not allow limitations on the duration of an implied warranty,so the above limitation or exclusion might not apply to you. This warranty gives you specific legal rightsand you might also have other rights that vary from country/region to country/region, state to state, orprovince to province.
 HP's limited warranty is valid in any country/region or locality where HP has a support presence forthis product and where HP has marketed this product. The level of warranty service you receive mayvary according to local standards. HP will not alter form, fit or function of the product to make itoperate in a country/region for which it was never intended to function for legal or regulatory reasons.
 TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT AREYOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP ORITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL,CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASEDIN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or provinces do not allow theexclusion or limitation of incidental or consequential damages, so the above limitation or exclusion maynot apply to you.
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THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLYPERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THEMANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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HP's Premium Protection Warranty: LaserJet printcartridge limited warranty statement
 This HP product is warranted to be free from defects in materials and workmanship.
 This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured ortampered with in any way, (b) experience problems resulting from misuse, improper storage, oroperation outside of the published environmental specifications for the printer product or (c) exhibitwear from ordinary use.
 To obtain warranty service, please return the product to place of purchase (with a written description ofthe problem and print samples) or contact HP customer support. At HP's option, HP will either replaceproducts that prove to be defective or refund your purchase price.
 TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NOOTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIEDAND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OFMERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
 TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLEFOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OROTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.
 THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLYPERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THEMANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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End User License AgreementPLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User LicenseAgreement (“EULA”) is a contract between (a) you (either an individual or the entity you represent) and(b) Hewlett-Packard Company (“HP”) that governs your use of the software product (“Software”). ThisEULA does not apply if there is a separate license agreement between you and HP or its suppliers forthe Software, including a license agreement in online documentation. The term “Software” may include(i) associated media, (ii) a user guide and other printed materials, and (iii) “online” or electronicdocumentation (collectively “User Documentation”).
 RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO ALLTERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING, OROTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU DO NOTACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE SOFTWARE. IFYOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA, PLEASE RETURN THESOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN DAYS FOR A REFUND OF THEPURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR MADE AVAILABLE WITH ANOTHERHP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED PRODUCT.
 1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software(“HP Software”), software under licenses from third parties (“Third Party Software” and “Third PartyLicense”). Any Third Party Software is licensed to you subject to the terms and conditions of thecorresponding Third Party License. Generally, the Third Party License is located in a file such aslicense.txt; you should contact HP support if you cannot find any Third Party License. If the Third PartyLicenses include licenses that provide for the availability of source code (such as the GNU GeneralPublic License) and the corresponding source code is not included with the Software, then check theproduct support pages of HP’s website (hp.com) to learn how to obtain such source code.
 2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms andconditions of this EULA:
 a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing, copying,storing, loading, executing, displaying, or otherwise using the HP Software. You may not modify theHP Software or disable any licensing or control feature of the HP Software. If this Software is providedby HP for Use with an imaging or printing product (for example, if the Software is a printer driver,firmware, or add-on), the HP Software may only be used with such product (“HP Product”). Additionalrestrictions on Use may appear in the User Documentation. You may not separate component parts ofthe HP Software for Use. You do not have the right to distribute the HP Software.
 b. Copying. Your right to copy means you may make archival or back-up copies of the HP Software,provided each copy contains all the original HP Software’s proprietary notices and is used only forback-up purposes.
 3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement (collectively“Upgrade”), you must first be licensed for the original HP Software identified by HP as eligible for theUpgrade. To the extent the Upgrade supersedes the original HP Software, you may no longer use suchHP Software. This EULA applies to each Upgrade unless HP provides other terms with the Upgrade. Incase of a conflict between this EULA and such other terms, the other terms will prevail.
 4. TRANSFER.
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a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer of theHP Software to another end user. Any transfer will include all component parts, media, UserDocumentation, this EULA, and if applicable, the Certificate of Authenticity. The transfer may not be anindirect transfer, such as a consignment. Prior to the transfer, the end user receiving the transferredSoftware will agree to this EULA. Upon transfer of the HP Software, your license is automaticallyterminated.
 b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for commercialtimesharing or bureau use. You may not sublicense, assign or otherwise transfer the HP Softwareexcept as expressly provided in this EULA.
 5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation areowned by HP or its suppliers and are protected by law, including applicable copyright, trade secret,patent, and trademark laws. You will not remove any product identification, copyright notice, orproprietary restriction from the Software.
 6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, ordisassemble the HP Software, except and only to the extent that the right to do so is allowed underapplicable law.
 7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information youprovide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of supportservices related to the Software or the HP Product. All such information will be subject to HP’s privacypolicy. HP will not use such information in a form that personally identifies you except to the extentnecessary to enhance your Use or provide support services.
 8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability ofHP and its suppliers under this EULA and your exclusive remedy under this EULA will be limited to thegreater of the amount actually paid by you for the Product or U.S. $5.00. TO THE MAXIMUM EXTENTPERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR ANYSPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FORLOST PROFITS, LOST DATA, BUSINESS INTERRUPTION, PERSONAL INJURY, OR LOSS OF PRIVACY)RELATED IN ANY WAY TO THE USE OF OR INABILITY TO USE THE SOFTWARE, EVEN IF HP ORANY SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND EVEN IF THEABOVE REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some states or other jurisdictions do not allowthe exclusion or limitation of incidental or consequential damages, so the above limitation or exclusionmay not apply to you.
 9. U.S. GOVERNMENT CUSTOMERS. If you are a U.S. Government entity, then consistent with FAR12.211 and FAR 12.212, Commercial Computer Software, Computer Software Documentation, andTechnical Data for Commercial Items are licensed under the applicable HP commercial licenseagreement.
 10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)applicable to the export or import of the Software, or (ii) restricting the Use of the Software, includingany restrictions on nuclear, chemical, or biological weapons proliferation.
 11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to you inthis EULA.
 (c) 2007 Hewlett-Packard Development Company, L.P.
 Rev. 11/06
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Customer self-repair warranty serviceHP products are designed with many Customer Self Repair (CSR) parts to minimize repair time andallow for greater flexibility in performing defective parts replacement. If during the diagnosis period,HP identifies that the repair can be accomplished by the use of a CSR part, HP will ship that partdirectly to you for replacement. There are two categories of CSR parts: 1) Parts for which customer selfrepair is mandatory. If you request HP to replace these parts, you will be charged for the travel andlabor costs of this service. 2) Parts for which customer self repair is optional. These parts are alsodesigned for Customer Self Repair. If, however, you require that HP replace them for you, this may bedone at no additional charge under the type of warranty service designated for your product.
 Based on availability and where geography permits, CSR parts will be shipped for next business daydelivery. Same-day or four-hour delivery may be offered at an additional charge where geographypermits. If assistance is required, you can call the HP Technical Support Center and a technician willhelp you over the phone. HP specifies in the materials shipped with a replacement CSR part whether adefective part must be returned to HP. In cases where it is required to return the defective part to HP,you must ship the defective part back to HP within a defined period of time, normally five (5) businessdays. The defective part must be returned with the associated documentation in the provided shippingmaterial. Failure to return the defective part may result in HP billing you for the replacement. With acustomer self repair, HP will pay all shipping and part return costs and determine the courier/carrier tobe used.
 Customer support
 Get telephone support for your country/region
 Have the product name, serial number, date of purchase, andproblem description ready.
 Country/region phone numbers are on the flyer that was inthe box with your product or at www.hp.com/support/.
 Get 24-hour Internet support www.hp.com/support/ljp1100series
 Get support for products used with a Macintosh computer www.hp.com/go/macosx
 Download software utilities, drivers, and electronicinformation
 www.hp.com/support/ljp1100series
 Order additional HP service or maintenance agreements www.hp.com/go/carepack
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Repack the productIf HP Customer Care determines that your product needs to be returned to HP for repair, follow thesesteps to repack the product before shipping it.
 CAUTION: Shipping damage as a result of inadequate packing is the customer’s responsibility.
 1. Remove and retain the print cartridge.
 CAUTION: It is extremely important to remove the print cartridge before shipping the product. Aprint cartridge that remains in the product during shipping can leak and cover the product engineand other parts with toner.
 To prevent damage to the print cartridge, avoid touching the roller on it, and store the printcartridge in its original packing material or so that it is not exposed to light.
 2. Remove and retain the power cable, interface cable, and optional accessories, such as an EIOcard.
 3. If possible, include print samples and 50 to 100 sheets of paper or other print media that did notprint correctly.
 4. In the U.S., call HP Customer Care to request new packing material. In other areas, use theoriginal packing material, if possible. Hewlett-Packard recommends insuring the equipment forshipment.
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C Specifications
 ● Physical specifications
 ● Power consumption, electrical specifications, and acoustic emissions
 ● Environmental specifications
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Physical specificationsTable C-1 Physical specifications1
 Specification HP LaserJet Professional P1100 Printer series
 Product weight 4.7 kg (10.4 lb)
 Product height 194 mm (7.6 in)
 Product depth 224 mm (8.8 in)
 Product width 347 mm (13.7 in)
 1 Values are based on preliminary data. See www.hp.com/support/ljp1100series.
 Power consumption, electrical specifications, andacoustic emissions
 See www.hp.com/go/ljp1100_regulatory for current information.
 Environmental specificationsTable C-2 Environmental specifications
 Operating1 Storage1
 Temperature 15° to 32.5°C (59° to 90.5°F) -20° to 40°C (-4° to 104°F)
 Relative Humidity 10% to 80% 10% to 90%
 1 Values are based on preliminary data. See www.hp.com/support/ljp1100series.
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D Regulatory information
 ● FCC regulations
 ● Environmental product stewardship program
 ● Declaration of Conformity (HP LaserJet Professional P1102, P1102s, P1106, and P1108)
 ● Declaration of Conformity (HP LaserJet Professional P1102w)
 ● Declaration of Conformity (HP LaserJet Pro P1102w)
 ● Safety statements
 ● Additional statements for wireless products
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FCC regulationsThis equipment has been tested and found to comply with the limits for a Class B digital device,pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protectionagainst harmful interference in a residential installation. This equipment generates, uses, and canradiate radio frequency energy. If this equipment is not installed and used in accordance with theinstructions, it may cause harmful interference to radio communications. However, there is no guaranteethat interference will not occur in a particular installation. If this equipment does cause harmfulinterference to radio or television reception, which can be determined by turning the equipment off andon, the user is encouraged to try to correct the interference by one or more of the following measures:
 ● Reorient or relocate the receiving antenna.
 ● Increase separation between equipment and receiver.
 ● Connect equipment to an outlet on a circuit different from that to which the receiver is located.
 ● Consult your dealer or an experienced radio/TV technician.
 NOTE: Any changes or modifications to the printer that are not expressly approved by HP could voidthe user’s authority to operate this equipment.
 Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.
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Environmental product stewardship program
 Protecting the environment
 Hewlett-Packard Company is committed to providing quality products in an environmentally soundmanner. This product has been designed with several attributes to minimize impacts on ourenvironment.
 Ozone production
 This product generates no appreciable ozone gas (O3).
 Power consumption
 Power usage drops significantly while in Ready or Auto-Off mode, which saves natural resources andsaves money without affecting the high performance of this product. Hewlett-Packard printing andimaging equipment marked with the ENERGY STAR® logo is qualified to the U.S. EnvironmentalProtection Agency's ENERGY STAR specifications for imaging equipment. The following mark willappear on ENERGY STAR qualified imaging products:
 Additional ENERGY STAR qualified imaging product model information is listed at:
 www.hp.com/go/energystar
 Toner consumption
 EconoMode uses less toner, which might extend the life of the print cartridge.
 Paper use
 This product’s manual duplex feature (two-sided printing) and N-up printing (multiple pages printed onone page) capability can reduce paper usage and the resulting demands on natural resources.
 Plastics
 Plastic parts over 25 grams are marked according to international standards that enhance the ability toidentify plastics for recycling purposes at the end of the product’s life.
 HP LaserJet print supplies
 It’s easy to return and recycle your HP LaserJet print cartridges after use—free of charge—withHP Planet Partners. Multilingual program information and instructions are included in every new
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HP LaserJet print cartridge and supplies package. You help reduce the toll on the environment furtherwhen you return multiple cartridges together rather than separately.
 HP is committed to providing inventive, high-quality products and services that are environmentallysound, from product design and manufacturing to distribution, customer use and recycling. When youparticipate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycledproperly, processing them to recover plastics and metals for new products and diverting millions of tonsof waste from landfills. Since this cartridge is being recycled and used in new materials, it will not bereturned to you. Thank you for being environmentally responsible!
 NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use thislabel for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warrantyreturns. For information about recycling your HP inkjet cartridges please go to http://www.hp.com/recycle.
 Return and recycling instructions
 United States and Puerto Rico
 The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or moreHP LaserJet print cartridges after use. Please follow the applicable instructions below.
 Multiple returns (more than one cartridge)
 1. Package each HP LaserJet print cartridge in its original box and bag.
 2. Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg(70 lb).
 3. Use a single pre-paid shipping label.
 OR
 1. Use your own suitable box, or request a free bulk collection box from www.hp.com/recycle or1-800-340-2445 (holds up to 31 kg (70 lb) of HP LaserJet print cartridges).
 2. Use a single pre-paid shipping label.
 Single returns
 1. Package the HP LaserJet print cartridge in its original bag and box.
 2. Place the shipping label on the front of the box.
 Shipping
 For all HP LaserJet print cartridge recycling returns, give the package to UPS during your next deliveryor pickup, or take it to an authorized UPS drop-off center. For the location of your local UPS drop-offcenter, call 1-800-PICKUPS or visit www.ups.com. If you are returning via USPS label, give thepackage to a U.S. Postal Service carrier or drop off at a U.S. Postal Service Office. For moreinformation, or to order additional labels or boxes for bulk returns, visit www.hp.com/recycle or call1-800-340-2445. Requested UPS pickup will be charged normal pickup rates. Information subject tochange without notice.
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Residents of Alaska and Hawaii
 Do not use the UPS label. Call 1-800-340-2445 for information and instructions. The U.S. PostalService provides no-cost cartridge return transportation services under an arrangement with HP forAlaska and Hawaii.
 Non-U.S. returns
 To participate in HP Planet Partners return and recycling program, just follow the simple directions inthe recycling guide (found inside the packaging of your new product supply item) or visitwww.hp.com/recycle. Select your country/region for information on how to return your HP LaserJetprinting supplies.
 Paper
 This product is capable of using recycled papers when the paper meets the guidelines outlined in theHP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paperaccording to EN12281:2002.
 Material restrictions
 This HP product does not contain added mercury.
 This HP product does not contain a battery.
 Disposal of waste equipment by users in private households in theEuropean Union
 This symbol on the product or on its packaging indicates that this product must not be disposed of withyour other household waste. Instead, it is your responsibility to dispose of your waste equipment byhanding it over to a designated collection point for the recycling of waste electrical and electronicequipment. The separate collection and recycling of your waste equipment at the time of disposal willhelp to conserve natural resources and ensure that it is recycled in a manner that protects human healthand the environment. For more information about where you can drop off your waste equipment forrecycling, please contact your local city office, your household waste disposal service or the shopwhere you purchased the product.
 Chemical substances
 HP is committed to providing our customers with information about the chemical substances in ourproducts as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006of the European Parliament and the Council). A chemical information report for this product can befound at: www.hp.com/go/reach.
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Material Safety Data Sheet (MSDS)
 Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/community/environment/productinfo/safety.
 For more information
 To obtain information about these environmental topics:
 ● Product environmental profile sheet for this and many related HP products
 ● HP’s commitment to the environment
 ● HP’s environmental management system
 ● HP’s end-of-life product return and recycling program
 ● Material Safety Data Sheets
 Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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Declaration of Conformity (HP LaserJet ProfessionalP1102, P1102s, P1106, and P1108)
 Declaration of Conformity
 according to ISO/IEC 17050-1 and EN 17050-1
 Manufacturer's Name: Hewlett-Packard Information Technology R&D(Shanghai) Co., Ltd.
 DoC#: BOISB-0901-00-rel.4.0
 Manufacturer's Address: Building 6, No. 690 BiBo Road, ZhangJiang, Shanghai, China
 declares, that the product
 Product Name: HP LaserJet Professional P1102
 HP LaserJet Pro P1102s/P1106/P1108
 Regulatory Model:2) BOISB-0901-00
 Product Options: ALL
 Print Cartridges: CE285A, CC388A
 conforms to the following Product Specifications:
 SAFETY: IEC 60950-1:2005 / EN60950-1: 2006 +A11:2009
 IEC 60825-1:2007 / EN 60825-1:2007 (Class 1 Laser/LED Product)
 IEC 62311:2007 / EN62311:2008
 GB4943-2001
 EMC: CISPR22:2005 +A1 / EN55022:2006 +A1 - Class B1)
 EN 61000-3-2:2006
 EN 61000-3-3:2008
 EN 55024:1998 +A1 +A2
 FCC Title 47 CFR, Part 15 Class B / ICES-003, Issue 4
 GB9254-2008, GB17625.1-2003
 ENERGY USE: Regulation (EC) No. 1275/2008
 ENERGY STAR® Qualified Imaging Equipment Typical Electricity Consumption (TEC) Test Procedure
 Supplementary Information:
 The product herewith complies with the requirements of the EMC Directive 2004/108/EC, the Low Voltage Directive 2006/95/EC and the
 EuP Directive 2005/32/EC, and carries the CE-Marking accordingly.
 This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not causeharmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
 1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.
 2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the productname or the product number(s).
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Shanghai, China
 December 2010
 For Regulatory Topics only, contact:
 European Contact Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-TRE / Standards Europe, Herrenberger Straße 140, D-71034 Böblingen (FAX: +49-7031-14-3143)www.hp.eu/certificates
 USA Contact Product Regulations Manager, Hewlett-Packard, 3000 Hanover St., Palo Alto 94304, U.S.A.1-650-857-1501
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Declaration of Conformity (HP LaserJet ProfessionalP1102w)
 Declaration of Conformity
 according to ISO/IEC 17050-1 and EN 17050-1
 Manufacturer's Name: Hewlett-Packard Information Technology R&D(Shanghai) Co., Ltd.
 DoC#: BOISB-0901-01-rel.6.0
 Manufacturer's Address: Building 6, No. 690 BiBo Road, ZhangJiang, Shanghai, China
 declares, that the product
 Product Name: HP LaserJet Professional P1102w
 Regulatory Model:2) BOISB-0901-01
 Product Options: ALL
 Radio Module3) BOISB-0803-00
 Print Cartridges: CE285A
 conforms to the following Product Specifications:
 SAFETY: IEC 60950-1:2005 / EN60950-1: 2006 +A11:2009
 IEC 60825-1:2007 / EN 60825-1:2007 (Class 1 Laser/LED Product)
 IEC 62311:2007 / EN62311:2008
 GB4943-2001
 EMC: CISPR22:2005 +A1/ EN55022:2006 +A1 - Class B1)
 EN 61000-3-2:2006
 EN 61000-3-3:2008
 EN 55024:1998 +A1 +A2
 FCC Title 47 CFR, Part 15 Class B1) / ICES-003, Issue 4
 GB9254-2008, GB17625.1-2003
 Radio3) EN 301 489-1 V1.8.1 / EN 301 489-17 V2.1.1
 EN 300 328 V1.7.1
 FCC Title 47 CFR, Part 15 Subpart C (Section 15.247) / IC: RSS-210
 ENERGY USE: Regulation (EC) No. 1275/2008
 ENERGY STAR® Qualified Imaging Equipment Typical Electricity Consumption (TEC) Test Procedure
 Supplementary Information:
 The product herewith complies with the requirements of the R&TTE Directive 1999/5/EC Annex IV, EMC Directive 2004/108/EC, the Low
 Voltage Directive 2006/95/EC and the EuP Directive 2005/32/EC, and carries the CE-Marking accordingly.
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This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not causeharmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
 1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.
 2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the productname or the product number(s).
 3. This product uses a radio module device which Regulatory Model number is BOISB--0803-00 as needed to meet technical regulatoryrequirements for the countries/regions this product will be sold.
 Shanghai, China
 December 2010
 For Regulatory Topics only, contact:
 European Contact Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-TRE / Standards Europe, Herrenberger Straße 140, D-71034 Böblingen (FAX: +49-7031-14-3143)www.hp.eu/certificates
 USA Contact Product Regulations Manager, Hewlett-Packard, 3000 Hanover St., Palo Alto 94304, U.S.A.1-650-857-1501
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Declaration of Conformity (HP LaserJet Pro P1102w)
 Declaration of Conformity
 according to ISO/IEC 17050-1 and EN 17050-1
 Manufacturer's Name: Hewlett-Packard Information Technology R&D(Shanghai) Co., Ltd.
 DoC#: BOISB-0901-06-rel.1.0
 Manufacturer's Address: Building 6, No. 690 BiBo Road, ZhangJiang, Shanghai, China
 declares, that the product
 Product Name: HP LaserJet Pro P1102w
 Regulatory Model:2) BOISB-0901-06
 Product Options: ALL
 Radio Module3) SDGOB-0892
 Print Cartridges: CE285A
 conforms to the following Product Specifications:
 SAFETY: IEC 60950-1:2005 / EN60950-1: 2006 +A11:2009
 IEC 60825-1:2007 / EN 60825-1:2007 (Class 1 Laser/LED Product)
 IEC 62311:2007 / EN62311:2008
 GB4943-2001
 EMC: CISPR22:2005 +A1/ EN55022:2006 +A1 - Class B1)
 EN 61000-3-2:2006
 EN 61000-3-3:2008
 EN 55024:1998 +A1 +A2
 FCC Title 47 CFR, Part 15 Class B / ICES-003, Issue 4
 GB9254-2008, GB17625.1-2003
 Radio3) EN 301 489-1 V1.8.1 / EN 301 489-17 V2.1.1
 EN 300 328 V1.7.1
 FCC Title 47 CFR, Part 15 Subpart C (Section 15.247) / IC: RSS-210
 ENERGY USE: Regulation (EC) No. 1275/2008
 ENERGY STAR® Qualified Imaging Equipment Typical Electricity Consumption (TEC) Test Procedure
 Supplementary Information:
 The product herewith complies with the requirements of the R&TTE Directive 1999/5/EC Annex IV, EMC Directive 2004/108/EC, the Low
 Voltage Directive 2006/95/EC and the EuP Directive 2005/32/EC, and carries the CE-Marking accordingly.
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This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not causeharmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
 1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.
 2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the productname or the product number(s).
 3. This product uses a radio module device which Regulatory Model number is SDGOB-0892 as needed to meet technical regulatoryrequirements for the countries/regions this product will be sold.
 Shanghai, China
 December 2010
 For Regulatory Topics only, contact:
 European Contact Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-TRE / Standards Europe, Herrenberger Straße 140, D-71034 Böblingen (FAX: +49-7031-14-3143)www.hp.eu/certificates
 USA Contact Product Regulations Manager, Hewlett-Packard, 3000 Hanover St., Palo Alto 94304, U.S.A.1-650-857-1501
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Safety statements
 Laser safety
 The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration hasimplemented regulations for laser products manufactured since August 1, 1976. Compliance ismandatory for products marketed in the United States. The device is certified as a “Class 1” laserproduct under the U.S. Department of Health and Human Services (DHHS) Radiation PerformanceStandard according to the Radiation Control for Health and Safety Act of 1968. Since radiationemitted inside the device is completely confined within protective housings and external covers, thelaser beam cannot escape during any phase of normal user operation.
 WARNING! Using controls, making adjustments, or performing procedures other than thosespecified in this user guide may result in exposure to hazardous radiation.
 Canadian DOC regulations
 Complies with Canadian EMC Class B requirements.
 « Conforme à la classe B des normes canadiennes de compatibilité électromagnétiques. « CEM ». »
 VCCI statement (Japan)
 Power cord instructions
 Make sure your power source is adequate for the product voltage rating. The voltage rating is on theproduct label. The product uses either 110-127 Vac or 220-240 Vac and 50/60 Hz.
 Connect the power cord between the product and a grounded AC outlet.
 CAUTION: To prevent damage to the product, use only the power cord that is provided with theproduct.
 Power cord statement (Japan)
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EMC statement (Korea)
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Laser statement for Finland
 Luokan 1 laserlaite
 Klass 1 Laser Apparat
 HP LaserJet Professional P1100, P1100w, laserkirjoitin on käyttäjän kannalta turvallinen luokan 1laserlaite. Normaalissa käytössä kirjoittimen suojakotelointi estää lasersäteen pääsyn laitteenulkopuolelle. Laitteen turvallisuusluokka on määritetty standardin EN 60825-1 (1994) mukaisesti.
 VAROITUS !
 Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjänturvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.
 VARNING !
 Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas förosynlig laserstrålning, som överskrider gränsen för laserklass 1.
 HUOLTO
 HP LaserJet Professional P1100, P1100w - kirjoittimen sisällä ei ole käyttäjän huollettavissa oleviakohteita. Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu henkilö. Tällaiseksihuoltotoimenpiteeksi ei katsota väriainekasetin vaihtamista, paperiradan puhdistusta tai muita käyttäjänkäsikirjassa lueteltuja, käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan suorittaa ilmanerikoistyökaluja.
 VARO !
 Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessatoiminnassa. Älä katso säteeseen.
 VARNING !
 Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynliglaserstrålning. Betrakta ej strålen. Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista:Aallonpituus 775-795 nm Teho 5 m W Luokan 3B laser.
 GS statement (Germany)
 Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatzvorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produktnicht im unmittelbaren Gesichtsfeld platziert warden.
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Substances Table (China)
 Restriction on Hazardous Substances statement (Turkey)
 Türkiye Cumhuriyeti: EEE Yönetmeliğine Uygundur
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Additional statements for wireless products
 FCC compliance statement—United States
 Exposure to radio frequency radiation
 CAUTION: The radiated output power of this device is far below the FCC radio frequency exposurelimits. Nevertheless, the device shall be used in such a manner that the potential for human contactduring normal operation is minimized.
 In order to avoid the possibility of exceeding the FCC radio frequency exposure limits, human proximityto the antenna shall not be less than 20 cm ( (8 in)) during normal operation.
 This device complies with Part 15 of FCC Rules. Operation is subject to the following two conditions:(1) this device may not cause interference, and (2) this device must accept any interference, includinginterference that may cause undesired operation of the device.
 CAUTION: Based on Section 15.21 of the FCC rules, changes of modifications to the operation ofthis product without the express approval by Hewlett-Packard Company may invalidate its authorizeduse.
 Australia statement
 This device incorporates a radio-transmitting (wireless) device. For protection against radio transmissionexposure, it is recommended that this device be operated no less than 20 cm from the head, neck, orbody.
 Brazil ANATEL statement
 Este equipamento opera em caráter secundário, isto é, não tem direito à proteção contra interferênciaprejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência a sistemas operandoem caráter primário.
 Canadian statements
 For Indoor Use. This digital apparatus does not exceed the Class B limits for radio noise emissionsfrom digital apparatus as set out in the radio interference regulations of the Canadian Department ofCommunications. The internal wireless radio complies with RSS 210 of Industry Canada.
 Pour l´usage d´intérieur. Le présent appareil numérique n´émet pas de bruits radioélectriquesdépassant les limites applicables aux appareils numériques de Classe B prescribes dans le règlementsur le brouillage radioélectrique édicté par le Ministère des Communications du Canada. Le composantRF interne est conforme à la norme CNR-210 d´Industrie Canada.
 European Union regulatory notice
 The telecommunications functionality of this product may be used in the following EU and EFTAcountries/regions:
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Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany,Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta,Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden,Switzerland, and United Kingdom.
 Notice for use in France
 For 2.4 GHz Wireless LAN operation of this product certain restrictions apply: This equipment may beused indoor for the entire 2400-2483.5 MHz frequency band (channels 1-13). For outdoor use, only2400-2454 MHz frequency band (channels 1-9) may be used. For the latest requirements, seewww.arcep.fr.
 L'utilisation de cet equipement (2.4 GHz Wireless LAN) est soumise à certaines restrictions : Cetéquipement peut être utilisé à l'intérieur d'un bâtiment en utilisant toutes les fréquences de2400-2483.5 MHz (Chaine 1-13). Pour une utilisation en environnement extérieur, vous devez utiliserles fréquences comprises entre 2400-2454 MHz (Chaine 1-9). Pour les dernières restrictions, voir,www.arcep.fr.
 Notice for use in Russia
 Существуют определенные ограничения по использованию беспроводных сетей (стандарта802.11 b/g) с рабочей частотой 2,4 ГГц: Данное оборудование может использоваться внутрипомещений с использованием диапазона частот 2400-2483,5 МГц (каналы 1-13). Прииспользовании внутри помещений максимальная эффективная изотропно–излучаемая мощность(ЭИИМ) должна составлять не более 100мВт.
 Korean statement
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Taiwan statement
 Vietnam Telecom wired marking for ICTQC Type approvedproducts
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